Contents

1  Safety

Electrical Safety ........................................................................................................... 10
  General Guidelines. .................................................................................................... 10
  Laser Safety ............................................................................................................... 10
  Power Cord ............................................................................................................... 10
Operational Safety ........................................................................................................ 12
  Operational Guidelines. ............................................................................................ 12
  Ozone Release. .......................................................................................................... 12
  Printer Location. ........................................................................................................ 12
  Printer Supplies ........................................................................................................ 13
Maintenance Safety ...................................................................................................... 14
Printer Symbols ............................................................................................................ 15

2  Features

Parts of the Printer ........................................................................................................ 18
  Front View .............................................................................................................. 18
  Rear View .............................................................................................................. 19
  Internal Components ............................................................................................... 19
  Control Panel .......................................................................................................... 20
Configurations and Options .......................................................................................... 21
  Configurations ........................................................................................................ 21
  Standard Features ................................................................................................... 21
  Additional Capabilities ............................................................................................ 21
  Optional Features .................................................................................................... 22
Energy Saver Mode ....................................................................................................... 23
  Setting the Power Saver Time ............................................................................... 23
  Exiting Energy Saver Mode .................................................................................... 23
  Starting Energy Saver Mode ................................................................................... 23
Information Pages ......................................................................................................... 24
  Menu Map .............................................................................................................. 24
  Configuration Page ................................................................................................. 24
  Startup Page ........................................................................................................... 24
CentreWare Internet Services ....................................................................................... 25
  Accessing CentreWare Internet Services ............................................................... 25
More Information ........................................................................................................ 26

3  Installation and Setup

Installation and Setup Overview .................................................................................... 28
Selecting a Location for the Printer ............................................................................... 29
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printing Custom Sizes</td>
<td>78</td>
</tr>
<tr>
<td>Defining Custom Paper Sizes</td>
<td>78</td>
</tr>
<tr>
<td>Printing on Custom-size Paper</td>
<td>79</td>
</tr>
<tr>
<td>Printing on Both Sides of the Paper</td>
<td>81</td>
</tr>
<tr>
<td>Automatic 2-Sided Printing Guidelines</td>
<td>81</td>
</tr>
<tr>
<td>Binding Edge Options</td>
<td>81</td>
</tr>
<tr>
<td>Automatic 2-Sided Printing</td>
<td>82</td>
</tr>
<tr>
<td>Manual 2-Sided Printing</td>
<td>82</td>
</tr>
<tr>
<td>Printing Using Secure Print</td>
<td>84</td>
</tr>
<tr>
<td>Setting Up a Secure Print Job</td>
<td>84</td>
</tr>
<tr>
<td>Printing a Secure Print Job</td>
<td>85</td>
</tr>
<tr>
<td>Storing a Print Job in Memory</td>
<td>86</td>
</tr>
<tr>
<td>Printing a Stored Job</td>
<td>86</td>
</tr>
<tr>
<td>Printing Using Proof Print</td>
<td>87</td>
</tr>
<tr>
<td>Setting Up a Proof Print Job</td>
<td>87</td>
</tr>
<tr>
<td>Printing a Proof Print Job</td>
<td>88</td>
</tr>
<tr>
<td>250-Sheet Feeder (Tray 2) Settings</td>
<td>103</td>
</tr>
<tr>
<td>Tray 1 Settings</td>
<td>102</td>
</tr>
<tr>
<td>250-Sheet Feeder (Tray 2) Settings</td>
<td>103</td>
</tr>
<tr>
<td>5 Control Panel Menus</td>
<td></td>
</tr>
<tr>
<td>Navigating the Control Panel Menus</td>
<td>90</td>
</tr>
<tr>
<td>Information Pages Menu</td>
<td>91</td>
</tr>
<tr>
<td>Billing Meters</td>
<td>92</td>
</tr>
<tr>
<td>Admin Menu</td>
<td>93</td>
</tr>
<tr>
<td>Network Setup Menu</td>
<td>93</td>
</tr>
<tr>
<td>USB Setup Menu</td>
<td>94</td>
</tr>
<tr>
<td>System Setup Menu</td>
<td>95</td>
</tr>
<tr>
<td>Maintenance Mode Menu</td>
<td>97</td>
</tr>
<tr>
<td>PCL Setup Menu</td>
<td>98</td>
</tr>
<tr>
<td>PostScript Setup Menu</td>
<td>100</td>
</tr>
<tr>
<td>Control Panel Menu</td>
<td>101</td>
</tr>
<tr>
<td>Tray Settings Menu</td>
<td>102</td>
</tr>
<tr>
<td>Tray 1 Settings</td>
<td>102</td>
</tr>
<tr>
<td>5 Maintenance</td>
<td></td>
</tr>
<tr>
<td>Cleaning the Printer</td>
<td>106</td>
</tr>
<tr>
<td>General Precautions</td>
<td>106</td>
</tr>
<tr>
<td>Cleaning the Exterior</td>
<td>107</td>
</tr>
<tr>
<td>Cleaning the Interior</td>
<td>107</td>
</tr>
<tr>
<td>Ordering Supplies</td>
<td>108</td>
</tr>
<tr>
<td>Consumables</td>
<td>108</td>
</tr>
<tr>
<td>Routine Maintenance Items</td>
<td>108</td>
</tr>
<tr>
<td>When to Order Supplies</td>
<td>109</td>
</tr>
<tr>
<td>Recycling Supplies</td>
<td>109</td>
</tr>
</tbody>
</table>
Contents

6  Phaser 6500 Color Laser Printer
User Guide

Managing the Printer .......................................................... 110
  Managing the Printer with CentreWare Internet Services .... 110
  Checking Printer Status with PrintingScout ....................... 111
  Checking Printer Status using Email ............................... 112
Checking Page Counts ................................................... 115
  Viewing the Billing Meter ............................................. 115
  Printing the Print Volume Report .................................. 115
Moving the Printer .......................................................... 117

7  Troubleshooting

Troubleshooting Overview ............................................... 120
  Error and Status Messages .......................................... 120
  PrintingScout Alerts .................................................. 120
  Online Support Assistant ............................................ 120
  Information Pages .................................................... 120
  More Information ..................................................... 121
Control Panel Messages ................................................... 122
  Supply Status Messages .............................................. 122
  Error Messages ....................................................... 123
Problems with the Printer ............................................... 125
Print-Quality Problems .................................................. 128
Cleaning the Imaging Unit and Laser Lens ......................... 133
Color Registration ....................................................... 136
  Enabling/Disabling Automatic Color Registration ............. 136
  Performing an Automatic Color Registration Adjustment .... 136
  Performing a Manual Color Registration Adjustment ........ 137
Color Balance ............................................................. 140
Paper Jams ....................................................................... 141
  Preventing Paper Jams ................................................ 141
  Clearing Paper Jams .................................................... 142

8  Printer Specifications

Physical Specifications ...................................................... 148
  Weights and Dimensions .............................................. 148
Environmental Specifications .......................................... 149
  Temperature ................................................................ 149
  Relative Humidity ..................................................... 149
  Elevation ................................................................. 149
Electrical Specifications ................................................. 150
  Power Source .......................................................... 150
  Power Consumption .................................................. 150
Performance Specifications ............................................. 151
Contents

A  Regulatory Information

Electromagnetic Interference ....................................................... 154
  United States FCC Regulations ............................................. 154
  Canada Regulations .............................................................. 154
  European Union ................................................................. 155
Other Regulations ..................................................................... 156
  Turkey RoHS Regulation ......................................................... 156
Material Safety Data Sheets ....................................................... 157

B  Recycling and Disposal

  All Countries .......................................................................... 159
  North America ........................................................................ 159
  Other Countries ..................................................................... 159
  European Union ..................................................................... 159
Safety

This chapter includes:

- Electrical Safety on page 10
- Operational Safety on page 12
- Maintenance Safety on page 14
- Printer Symbols on page 15

Your printer and the recommended supplies have been designed and tested to meet strict safety requirements. Attention to the following information ensures the continued safe operation of your printer.
Safety

Electrical Safety

General Guidelines

**WARNING:** Do not push objects, including paper clips or staples, into slots or openings on the printer. Contact with a voltage point or shorting out a part could result in fire or electrical shock.

**WARNING:** Do not remove the covers or guards that are fastened with screws unless you are installing optional equipment and are instructed to do so. Power must be OFF when performing these installations. Disconnect the power cord when removing covers and guards for installing optional equipment. Except for user-installable options, there are no parts that you can maintain or service behind these covers.

*Note:* Leave the printer on for optimum performance; it does not pose a safety hazard. If, however, you do not use the printer for an extended period, turn it off and unplug it.

The following are hazards to your safety:
- The power cord is damaged or frayed.
- Liquid is spilled into the printer.
- The printer is exposed to water.

If any of these conditions occur, do the following:
1. Turn off the printer immediately.
2. Disconnect the power cord from the electrical outlet.
3. Call an authorized service representative.

Laser Safety

This printer complies with laser printer performance standards set by governmental, national, and international agencies and is certified as a Class 1 Laser Product. The printer does not emit hazardous light because the beam is enclosed during all modes of customer operation and maintenance.

**WARNING:** Use of controls, adjustments, or performance of procedures other than the procedures specified in this manual can result in hazardous radiation exposure.

Power Cord

- Use the power cord supplied with your printer.
- Plug the power cord directly into a grounded electrical outlet. Make sure that each end of the cord is securely connected. If you do not know if an outlet is grounded, ask an electrician to check the outlet.
- Do not use a ground adapter plug to connect the printer to an electrical outlet that does not have a ground connection terminal.
• Only use an extension cord or power strip designed to handle the electrical current capacity of the printer.

• Verify that the printer is plugged into an outlet that provides the correct voltage and power. Review the electrical specification of the printer with an electrician if necessary.

  **WARNING:** Avoid the potential of electrical shock by ensuring that the printer is properly grounded. Electrical products can be hazardous if misused.

• Do not place the printer in an area where people can step on the power cord.

• Do not place objects on the power cord.

The power cord is attached to the printer as a plug-in device on the back of the printer. If it is necessary to disconnect all electrical power from the printer, disconnect the power cord from the electrical outlet.
Operational Safety

Your printer and supplies were designed and tested to meet strict safety requirements. These include safety agency examination, approval, and compliance with established environmental standards. Your attention to the following safety guidelines helps to ensure the continued, safe operation of your printer.

Operational Guidelines

- Do not remove the paper source tray that you selected in either the print driver or the control panel, when the printer is printing.
- Do not open the doors when the printer is printing.
- Do not move the printer when it is printing.
- Keep hands, hair, neckties, and such, away from the exit and feed rollers.

Ozone Release

During print operation, a small quantity of ozone is released. This amount is not large enough to harm anyone adversely. However, be sure the room where the printer is being used has adequate ventilation. Ventilation is important if you are printing in high volume, or if the printer is being used continuously over a long period.

Printer Location

- Do not block or cover the slots or openings on the printer. These openings are provided for ventilation and to prevent overheating of the printer.
- Place the printer in a dust-free area where there is adequate space for operation and servicing. For details, see Selecting a Location for the Printer on page 29.
- Do not store or operate the printer in extreme conditions of heat or humidity. For specifications on optimum performance environment, see Environmental Specifications on page 149.
- Place the printer on a level, solid, non-vibrating surface with adequate strength to hold the weight of the printer. The base printer weight without any packaging materials is approximately 19.8 Kg (43.6 lb.).
- Do not place the printer near a heat source.
- Do not place the printer in direct sunlight to avoid exposure to light-sensitive components.
- Do not place the printer where it is directly exposed to the cold air flow from an air conditioning unit.
- Do not place the printer in locations susceptible to vibrations.
- For optimum performance, use the printer at elevations below 3100 m (10,170 ft.).
Printer Supplies

- Use the supplies designed for your printer. The use of unsuitable materials can cause poor performance and a possible safety hazard.
- Follow all warnings and instructions marked on, or supplied with, the printer, options, and supplies.

**CAUTION:** Use of non-Xerox® supplies is not recommended. The Xerox® Warranty, Service Agreements, and Total Satisfaction Guarantee, do not cover damage, malfunction, or degradation of performance caused by use of non-Xerox® supplies. They also do not cover damage or degradation of performance caused by the use of Xerox® supplies not specified for this printer. The Total Satisfaction Guarantee is available in the United States and Canada. Coverage can vary outside these areas. Please contact your local representative for details.
Maintenance Safety

- Do not attempt any maintenance procedure that is not described in the documentation supplied with your printer.
- Do not use aerosol cleaners. Clean with a dry, lint-free cloth only.
- Do not burn any consumables or routine maintenance items. For information on Xerox® supplies recycling programs, go to www.xerox.com/gwa.

See also:
- Cleaning the Printer on page 106
- Moving the Printer on page 117
## Printer Symbols

The following safety symbols are marked on the printer.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Warning or Caution:" /></td>
<td>Warning or Caution: Ignoring this warning could cause serious injury or even death. Ignoring this caution can damage the property or cause serious injury.</td>
</tr>
<tr>
<td><img src="image" alt="Hot surface" /></td>
<td>Hot surface on or in the printer. Use caution to avoid personal injury.</td>
</tr>
<tr>
<td><img src="image" alt="Do not expose" /></td>
<td>Do not expose the item to sunlight.</td>
</tr>
<tr>
<td><img src="image" alt="Do not expose" /></td>
<td>Do not expose the item to light.</td>
</tr>
<tr>
<td><img src="image" alt="Do not touch" /></td>
<td>Do not touch components with this symbol as personal injury could result.</td>
</tr>
<tr>
<td><img src="image" alt="Do not touch" /></td>
<td>Do not touch the transfer belt with your fingers or with sharp objects. It can cause print-quality problems. The belt can be easily punctured.</td>
</tr>
<tr>
<td><img src="image" alt="Do not place" /></td>
<td>Do not place or drop any object on the transfer belt. It can cause print-quality problems or permanently damage the belt.</td>
</tr>
<tr>
<td><img src="image" alt="Cooling time" /></td>
<td>It can take 40 minutes for the fuser to cool down.</td>
</tr>
</tbody>
</table>
Safety
Features

This chapter includes:

- Parts of the Printer on page 18
- Configurations and Options on page 21
- Energy Saver Mode on page 23
- Information Pages on page 24
- CentreWare Internet Services on page 25
- More Information on page 26
Parts of the Printer

This section includes:
- Front View on page 18
- Rear View on page 19
- Internal Components on page 19
- Control Panel on page 20

Front View

Phaser 6500 printer with optional 250-sheet feeder
1. Optional 250-sheet feeder (Tray 2)
2. Tray 1
3. Manual feed slot
4. Front cover
5. Control panel
6. Output tray
7. Button for opening the front cover and for releasing the duplex unit
8. Toner cartridges
Rear View

1. Power switch
2. Power cord connector
3. USB Port
4. Network connector
5. Optional memory slot

Internal Components

Phaser 6500DN Printer
1. Imaging unit
2. Fuser
3. Transfer belt unit with Tray 1 removed so the transfer belt unit folds down completely
4. Duplex unit
5. Button for opening the front cover and releasing the duplex unit
Control Panel

The control panel displays two screen types:
- Print screens, for displaying printer status.
- Menu screens, for configuring settings.

1. **Display Screen** shows status messages, menus, and toner levels.
2. **Menu** button selects the main menu to be displayed. Each button press advances the display to the next menu or to the print screen.
3. **OK** button selects the displayed menu option and prints selected reports and lists.
4. **Wake Up/Power Saver** button puts the printer into, or takes it out of the Energy Saver mode. When the printer is idle, it puts the printer into sleep mode and the button lights. When in the sleep mode, it wakes the printer and turns off the light in the button.
5. **Cancel Job** button cancels the current print or copy job.
6. **Navigation/Menu select** buttons:
   - **Up/Down Arrow** buttons scroll up and down through the menu display.
   - **Back/Forward Arrow** buttons move back and forward through the menus and menu display.
   **Note:** The **Back Arrow** button displays the Walk-Up Features menu if you press it before pressing any other buttons.
7. **Return** button navigates up one menu level.
8. **Status indicator** light
   - Lights green when the printer is ready to receive data.
   - Blinks green when the printer is busy receiving data.
   - Lights red to indicate an error condition or warning that requires your attention.
   - Blinks red when an error occurs that requires technical support.
   - Off when the printer is in Energy Saver mode.
Configurations and Options

This section includes:

- **Configurations** on page 21
- **Standard Features** on page 21
- **Additional Capabilities** on page 21
- **Optional Features** on page 22

Configurations

The Phaser 6500 printer is available in two configurations:

- Phaser 6500N: Includes all standard features.
- Phaser 6500DN: Includes all standard features plus a duplex unit.

*Note:* You can order additional memory, trays, and the duplex unit (for automatic 2-sided printing) when these items are not standard on your printer.

Standard Features

All configurations of the Phaser 6500 printer include the following features:

- Tray 1 with 250-sheet capacity
- Single-sheet manual feed slot
- 256 MB Memory (RAM)
  
  *Note:* All printer configurations have one memory slot supporting 512 MB or 1024 MB DDR2 DIMMs. Maximum RAM is 1280 MB (256 MB standard plus 1024 MB optional).
- 10Base-T/100/1000Base-TX Ethernet interface network connection
- USB 2.0 connection
- Energy Saver mode
- PrintingScout printer monitoring utility (Windows only)
- Printer information pages, including a Menu Map, Configuration Page, and Demo Page
- Billing meters
- Administration menu with control panel lock

Additional Capabilities

These features are built in to the printer but require additional memory to function. You can purchase additional memory. For details, see **Optional Features** on page 22.

- **Walk-Up Printing:** Prints a stored print job directly from the printer control panel.
- **RAM Disk:** Allocates memory to the RAM Disk file system for Collation, Secure Print, Proof Print, Form Overlay, and Font Download.
- **Collation:** Allows jobs to be stored in memory so that multiple copies can be printed in page sequence order: 123, 123, 123, 123, instead of 1111, 2222, 3333.
Features

- **Secure Print**: Stores data in memory and requires you to enter a password into the control panel to print the document.
- **Proof Print**: Stores multiple copies of a document in memory then allows you to print only the first set to check the print results. If the first copy is satisfactory, print the remainder from the printer control panel.
- **Form Overlay**: Enables writing PCL5 forms.
- **Font Download**: Enables the downloading of fonts to the RAM Disk.

Optional Features

- Duplex Unit for automatic 2-sided printing (optional for Phaser 6500N).
- 250-Sheet Feeder (Tray 2)
- Wireless Network Adapter
- Productivity Kit (512 MB) or 1024 MB memory upgrade

See also:

- Printer Specifications on page 147
- Enabling Optional Features on page 41
Energy Saver Mode

This section includes:
• Setting the Power Saver Time on page 23
• Exiting Energy Saver Mode on page 23
• Starting Energy Saver Mode on page 23

The printer is equipped with an Energy Saver mode to reduce power consumption when it is left idle for a specified time. When no print data is received within the Power Saver Time, default is 30 minutes, the printer enters Energy Saver mode. You can specify 5-60 ranges in one minute increments. Power consumption during Energy Saver mode is 8 W or less. The time required to exit from Energy Saver mode to a print-ready status is about 25 seconds.

Setting the Power Saver Time

1. On the printer control panel, press the Menu button.
2. Press the Down Arrow button to go to Admin Menu and then press the OK button.
3. Press the Down Arrow button to go System Setup and then press OK.
4. At Power Saver Time, press OK.
   Do one of the following:
   • To increase the amount of time, press the Up Arrow button until the desired time is reached. Maximum is 60 minutes.
   • To decrease the amount of time, press the Down Arrow button until the desired time is reached. Minimum is 5 minutes.
5. Press OK.
6. Press the Return button to return to the Main Menu.

Exiting Energy Saver Mode

The printer automatically cancels Energy Saver mode when it receives data from a connected computer. However, you can cancel Energy Saver mode by pressing the Power Saver button on the printer control panel. For details, see Control Panel on page 20.

Starting Energy Saver Mode

You can put the printer into Energy Saver mode without having to wait for it to do so automatically from the default settings. To enter into sleep mode, press the Power Saver button on the printer control panel. The printer must currently be idle and have been idle for at least one minute before you press the Power Saver button. The printer cannot enter Energy Saver mode when any of the following conditions exists:
• The printer is receiving data.
• The printer is calibrating after having been in Energy Saver mode or after a jam is cleared.
• You pressed another button within the last minute.
Information Pages

This section includes:

- **Menu Map** on page 24
- **Configuration Page** on page 24

Your printer comes with a set of information pages to help you track the performance of the printer and diagnose problems. Access the information pages from the printer control panel. The following topics discuss the most commonly used information pages. For a complete list of printer information pages, see Information Pages Menu on page 91.

**Menu Map**

The Menu Map lists all main and second-level menus. Use the Menu Map to navigate the printer control panel menus. The Menu Map also lists other information pages available for printing.

To print the Menu Map:
1. On the printer control panel, press the **Menu** button.
2. At **Information Pages**, press the **OK** button.
3. At **Menu Map**, press **OK**.

**Configuration Page**

The Configuration Page lists printer information such as default printer settings, installed options, network settings with IP address, and font settings. Use the information on this page to help you configure network settings for your printer, and to see page counts and system settings.

To print the Configuration Page:
1. On the printer control panel, press the **Menu** button.
2. At **Information Pages**, press the **OK** button.
3. Press the **Down Arrow** button to go to **Configuration** and then press **OK** to print.

**Startup Page**

The Startup Page is an abbreviated version of the Configuration Page without the details of the settings. Use the information on this page to help you configure network settings for your printer and to see page counts.

**Note:** By default, the Startup Page prints automatically each time the printer is turned on. You can turn off this feature in the System Setup Menu under the Admin Menu settings. For details, see System Setup Menu on page 95.
CentreWare Internet Services

CentreWare Internet Services is the administration and configuration software installed on the embedded Web server in the printer. It allows you to configure and administer the printer from a Web browser. CentreWare Internet Services gives you access to printer status, configuration and security settings, diagnostic functions, and more.

CentreWare Internet Services requires:
- A TCP/IP connection between the printer and the network in Windows, Macintosh, or Linux environment.
- TCP/IP and HTTP enabled on the printer.
- A network-connected computer with a Web browser that supports JavaScript.

Accessing CentreWare Internet Services

To access CentreWare Internet Services, you need the IP address of the printer. For details, see Finding the IP Address of Your Printer on page 35.

At your computer, open a Web browser, type the IP address of the printer into the address field, then press Enter or Return.
More Information

The following resources provide more information about your printer and its capabilities.

<table>
<thead>
<tr>
<th>Information</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installation Guide</td>
<td>Packaged with printer.</td>
</tr>
<tr>
<td>Quick Use Guide</td>
<td>Packaged with printer.</td>
</tr>
<tr>
<td>Video Tutorials</td>
<td><a href="http://www.xerox.com/office/6500docs">www.xerox.com/office/6500docs</a></td>
</tr>
</tbody>
</table>
| Recommended Media List    | Europe: [www.xerox.com/europaper](http://www.xerox.com/europaper)  
                          | North America: [www.xerox.com/paper](http://www.xerox.com/paper)  |
| Online Support Assistant  | [www.xerox.com/office/6500support](http://www.xerox.com/office/6500support) |
| Technical Support         | [www.xerox.com/office/6500support](http://www.xerox.com/office/6500support) |
| Xerox® Supplies           | [www.xerox.com/office/6500supplies](http://www.xerox.com/office/6500supplies) |
| Information Pages         | Print from the control panel menu.                         |
Installation and Setup

This chapter includes:

- Installation and Setup Overview on page 28
- Selecting a Location for the Printer on page 29
- Connecting the Printer on page 30
- Configuring Network Settings on page 32
- Installing the Print Drivers on page 36
- Installing PrintingScout on page 40
- Enabling Optional Features on page 41

See also:

Online Support Assistant at www.xerox.com/office/6500support

Installation Guide packaged with your printer.
Installation and Setup Overview

Before using the printer, you must:

1. Make sure that the printer is set up correctly in an appropriate location. For details, see Selecting a Location for the Printer on page 29.

2. Select a connection method. For details, see Choosing a Connection Method on page 30.

3. Make sure that the printer is connected correctly. For details, see Connecting the Printer on page 30.

4. Turn on the printer and the computer. The Startup Page prints by default. If it does not, see Startup Page on page 24. If you are connected to a network, keep the Startup Page for referencing network settings such as the IP address of your printer.

5. If connected to a network, configure network settings. For details, see Configuring Network Settings on page 32.

6. Install drivers and software utilities from the Software and Documentation disc. The software installation procedure used depends on your connection type (network or USB). For details, see Installing the Print Drivers on page 36.

Note: If the Software and Documentation disc is not available, you can download the latest drivers from www.xerox.com/office/6500drivers.
Selecting a Location for the Printer

1. Select a dust-free area with temperatures from 10° through 32°C (50°–90°F), and relative humidity from 15 through 85%.

   Note: Sudden temperature fluctuations can affect print quality. Rapid heating of a cold room can cause condensation inside the printer, directly interfering with image transfer.

2. Place the printer on a level, solid, non-vibrating surface with adequate strength for the weight of the printer. The printer must be horizontal with all four feet in solid contact with the surface. The printer weight, without the options or paper, is 19.8 Kg (43.6 lb.). With the 250-sheet feeder, the duplex unit, and supplies, the weight is 24.2 Kg (53.2 lb.).

3. Ensure that your printer has the proper amount of clearance for all of its features, including any options you purchased. See the following measurements.

   The recommended minimal spacing for the printer includes the following:

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Clearance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overhead Clearance</td>
<td>200 mm (7.9 in.) above the printer for clearance when opening the front door</td>
</tr>
<tr>
<td>Height Requirement</td>
<td>Printer: 416.1 mm (16.4 in.)</td>
</tr>
<tr>
<td></td>
<td>Printer with 250-sheet feeder: 523 mm (20.6 in.)</td>
</tr>
<tr>
<td>Other Clearances</td>
<td>100 mm (3.9 in.) behind the printer</td>
</tr>
<tr>
<td></td>
<td>600 mm (23.6 in.) in front of the printer</td>
</tr>
<tr>
<td></td>
<td>100 mm (3.9 in.) on the left side of the printer</td>
</tr>
<tr>
<td></td>
<td>250 mm (9.8 in.) on the right side of the printer</td>
</tr>
</tbody>
</table>

4. After positioning the printer, you are ready to connect it to the power source and computer or network. Go to the next section, Connecting the Printer on page 30.
Connecting the Printer

This section includes:
- Choosing a Connection Method on page 30
- Connecting to a Network on page 30
- Connecting using USB on page 31

Choosing a Connection Method

The printer can be connected to your computer using a USB cable or an Ethernet cable. The method you choose depends on whether your computer is connected to a network. A USB connection is a direct connection and is the easiest to set up. An Ethernet connection is used for networking. If you are going to use a network connection, understand how your computer is connected to your network. For example, if your computer is connected to the network by way of a router connected to a cable or DSL modem. For more information, see About TCP/IP and IP Addresses on page 32.

Note: Hardware and cabling requirements vary for the different connection methods. Routers, network hubs, network switches, modems, Ethernet, and USB cables are not included with your printer and must be purchased separately.

- **Network**: If your computer is connected to an office network or a home network, use an Ethernet cable to connect the printer to the network. You cannot connect the printer directly to the computer, it must be connected through a router or hub. An Ethernet network can be used for one or more computers and supports many printers and systems simultaneously. Ethernet connection is typically faster than USB and allows you direct access to the settings of the printer using CentreWare Internet Services.

- **USB**: If you are connecting the printer to one computer and do not have a network, use a USB connection. While a USB connection offers fast data speeds, it is not as fast as an Ethernet connection and does not provide access to CentreWare Internet Services.

Connecting to a Network

To connect the printer to a network:

1. Make sure that the printer is turned off.
2. Attach a category 5 or better Ethernet cable from the printer to the network or router socket. Use an Ethernet hub or router, and two or more Ethernet cables (one cable for each device). Connect the computer to the hub or router with one cable, then connect the printer to the hub or router with the second cable. Connect to any port on the hub or router except the uplink port.
3. Attach the power cord and then plug in the printer and turn it on. For safety information, see Power Cord on page 10.
4. Set or automatically discover the network IP address of the printer. Go to Assigning the IP Address of the Printer on page 32.
Connecting using USB

To use USB, you must have Windows Server 2003 and later or Windows XP SP1 and later. Macintosh users must use Mac OS X, version 10.5 and later.

To connect the printer to the computer using a USB cable:
1. Make sure that the printer is turned off.
2. Connect one end of a standard A/B USB 2.0 cable to the USB Port of the printer.
3. Attach the power cord and then plug in the printer and turn it on. For safety information, see Power Cord on page 10.
4. Connect the other end of the USB cable to the USB Port on the computer.
5. When the Windows Found New Hardware Wizard appears, cancel it.
6. You are ready to install the print drivers. Go to Installing the Print Drivers on page 36.
Configuring Network Settings

This section includes:

- About TCP/IP and IP Addresses on page 32
- Assigning the IP Address of the Printer on page 32
- Changing the IP Address Using CentreWare Internet Services on page 34
- Finding the IP Address of Your Printer on page 35

Note: These instructions apply to the printer when it is connected to a network. If you have a USB connection to the printer, you can skip this section.

About TCP/IP and IP Addresses

Computers and printers primarily use TCP/IP protocols to communicate over an Ethernet network. Generally, Macintosh computers use either TCP/IP or the Bonjour protocol to communicate with a network printer. For Macintosh OS X systems, TCP/IP is preferred. Unlike TCP/IP, however, Bonjour does not require printers or computers to have IP addresses.

With TCP/IP protocols, each printer and computer must have a unique IP address. Many networks and Cable and DSL routers have a Dynamic Host Configuration Protocol (DHCP) server. A DHCP server automatically assigns an IP address to every computer and printer on the network that is configured to use DHCP.

If you use a Cable or DSL router, see the documentation for your router for information on IP addressing.

Assigning the IP Address of the Printer

This section includes:

- Allowing the IP Address to be Assigned Automatically on page 33
- Assigning the IP Address Manually on page 33
- Changing the IP Address Using CentreWare Internet Services on page 34

By default, the printer is set to acquire an IP address from the network server using DHCP. Network addresses assigned by DHCP are temporary, however. After a specified time, the network could assign a new IP address to the printer. You can experience connectivity issues if the print driver is set to an IP address that changes periodically. To avoid problems, or if your network administrator requires a static IP address for the printer, you can assign the IP address to the printer. For details, see Assigning the IP Address Manually on page 33.

Note: You can view the IP address of your printer from either the Startup Page, Configuration Page, or the printer control panel. For details, see Finding the IP Address of Your Printer on page 35.
Allowing the IP Address to be Assigned Automatically

To re-enable automatic assigning of the IP address of the printer, follow these steps:
1. On the printer control panel, press the Menu button.
2. Press the Down Arrow button to go to Admin Menu, then press the OK button.
3. At Network Setup, press OK.
4. Press the Down Arrow button to scroll to TCP/IP and press OK.
5. Press the Down Arrow button to scroll to IPv4 and press OK.
6. At Get IP Address, press OK.
7. Press the Down Arrow button to scroll to DHCP/AutoIP and press OK.
8. Press the Return button to return to the main menu.

Assigning the IP Address Manually

These instructions are for assigning a static IP address to your printer from the control panel of the printer. Once an IP address is assigned, you can change it using CentreWare Internet Services.

To assign a static IP address to the printer, you need the following information to assign the IP address:
- An IP address properly configured for your network.
- The Network Mask address
- The default Router/Gateway address

If you are on a network managed by a network administrator, contact your network administrator to obtain the network information.

For home networks that use routers or other devices to connect the printer to the network, refer to the router or device instructions on assigning network addresses. The router or device documentation can give you a range of acceptable address numbers you can use. It is important that the addresses be similar to the IP addresses used by other printers and computers on the network, but not the same. Only the last digit must be different. For example, your printer can have the IPv4 address 192.168.1.2 while your computer has the IP address 192.168.1.3. Another device can have the IP address 192.168.1.4.

The router could assign the static IP address of the printer to another computer that obtains its IP address dynamically. To avoid having the IP address reassigned, give the printer an address at the higher end of the address range allowed by the router or device. For example, if your computer has IP address 192.168.1.2, and your router or device allows IP addresses to 192.168.1.25, select an IP address between 192.168.1.20 and 192.168.1.25.

To assign a static IP address to the printer:
1. On the printer control panel, press the Menu button.
2. Press the Down Arrow button to go to Admin Menu and then press the OK button.
3. At Network Setup, press OK.
4. Press the Down Arrow button to scroll to TCP/IP and press OK.
5. Press the Down Arrow button to scroll to IPv4 and press OK.
6. At Get IP Address, press OK.
7. Press the Down Arrow button to scroll to Panel and press OK to enable this option.

8. Press the Return button once to return to the IPv6 menu and then press the Down Arrow button to scroll to IP Address and press OK.
   You use the Up, Down, Back, and Forward Arrow buttons to select the IP address. When undefined, the address is 000.000.000.000. Beginning with the first bank of numbers, use the following method to select the IP address:

9. Press the Up Arrow button to scroll through the numbers until you reach the desired number. Press the Forward Arrow button once to go to the next bank of numbers. Repeat the process: Press the Up Arrow button until you reach the desired number. Press the Forward Arrow button once to move to the next bank, and so on. To scroll down through the numbers, press the Down Arrow button. To scroll quickly to a high number, hold down the button. To go back to a bank of numbers, press the Back Arrow button.

10. When finished, press OK to confirm the address.

11. Press the Back Arrow button once, press the Down Arrow button to go to Network Mask, then press OK. Repeat steps 9 and 10 to select the Network Mask address.

12. Press the Back Arrow button once, press the Down Arrow button to go to Gateway Address, then press OK. Repeat steps 9 and 10 to select the Gateway Address.

13. Print the Configuration Page to verify the new settings. For details, see Configuration Page on page 24.

14. You are ready to install software. Go to Installing the Print Drivers on page 36.

See also:
   Online Support Assistant at www.xerox.com/office/6500support

Changing the IP Address Using CentreWare Internet Services

To change the IP address of the printer using CentreWare Internet Services:
1. At your computer, open a Web browser, type the IP address of the printer into the address field, then press Enter or Return.

2. On the right side of the page, click the Properties button.

3. In the navigation pane on the left of the page, expand the Protocols link if it is not already expanded, then click TCP/IP.

4. The TCP/IP - IPv6 page opens. In the IPv4 section of the TCP/IP - Dual Stack window, make the desired changes. For example, to change the way the printer acquires the IP address, in the Get IP Address field, select a method from the drop-down list.

5. After changing the address information, scroll to the bottom of the page and click the Save Changes button.
Finding the IP Address of Your Printer

To install the print drivers for a network-connected printer, you need the IP address of your printer. You also need the IP address to access the settings of your printer through CentreWare Internet Services. The IP address of your printer is printed on the Configuration Page and can be displayed on the printer control panel.

To print the Configuration Page:
1. On the printer control panel, press the Menu button.
2. At Information Pages, press the OK button.
3. Press the Down Arrow button to go to Configuration and then press OK.
   The IP address of the printer is listed in the Network Setup section of the page.

   Note: The first time you turn on your printer, it automatically prints the Startup Page. If the IP address listed on the page is 0.0.0.0, the printer has not had time to acquire an IP address from the DHCP server. Wait a minute or two and then print the Configuration Page.

To get the IP address of the printer from the printer control panel:
1. On the printer control panel, press the Menu button.
2. Press the Down Arrow button to go to Admin Menu and then press the OK button.
3. At Network Setup, press OK.
4. Press the Down Arrow button to scroll to TCP/IP and press OK.
5. Press the Down Arrow button to scroll to IPv6 and press OK.
6. Press the Down Arrow button to scroll to IP Address and press OK.
   The IP address of the printer appears.
Installing the Print Drivers

This section includes:

- Operating System Requirements on page 36
- Available Drivers on page 37
- Installing the Print Drivers for Windows on page 38
- Installing the Print Driver for Macintosh OS X on page 38
- Adding the Printer for Macintosh OS X Version 10.5 and Later on page 39

Operating System Requirements

- Windows Server 2003 and later, or Windows XP SP1 and later
- Macintosh: OS X version 10.5 and later
- Linux: Your printer supports connection to Linux platforms through the network interface.
Available Drivers

To access special printing options, use a Xerox® print driver. Xerox® provides drivers for various page description languages and operating systems. The following print drivers are available. To download the latest drivers, go to www.xerox.com/office/6500drivers.

<table>
<thead>
<tr>
<th>Print Driver</th>
<th>Source</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adobe PostScript 3 Driver</td>
<td>Software disc and Web</td>
<td>The PostScript driver is recommended to take full advantage of the custom features and genuine Adobe PostScript of your printer. Default print driver.</td>
</tr>
<tr>
<td>PCL6</td>
<td>Software disc and Web</td>
<td>The Printer Command Language (PCL) driver can be used for applications requiring PCL.</td>
</tr>
<tr>
<td>Mac OS X version 10.5 and later Driver</td>
<td>Software disc and Web</td>
<td>This driver enables printing from a Mac OS X version 10.5 and later operating system.</td>
</tr>
<tr>
<td>Linux</td>
<td>Software disc</td>
<td>This driver enables printing from a Linux operating system.</td>
</tr>
<tr>
<td>Xerox® Global Print Driver</td>
<td>Web</td>
<td>This driver works with any printer on your network, including printers made by other manufacturers. It configures itself for your individual printer upon installation</td>
</tr>
<tr>
<td>Xerox® Mobile Express Driver™</td>
<td>Web</td>
<td>The express driver works with any printer that supports standard PostScript. It configures itself for the printer you select every time you print. If you travel frequently to the same sites, you can save your favorite printers in that location and the driver saves your settings.</td>
</tr>
</tbody>
</table>
Installing the Print Drivers for Windows

To install the print driver from the Software and Documentation disc:
1. Insert the disc into the appropriate disc drive of your computer. If the installer does not start automatically, navigate to the drive on your computer and double-click the Setup.exe installer file. The Easy Setup Navigator appears.
2. Click the Software Installation button in the lower left of the Easy Setup Navigator.
3. At the License Agreement screen, select the language at the top of the license agreement, then click I Agree to accept the license agreement. The Xerox® Printer Installation screen appears.
4. In the Discovered Printers list, select your Phaser 6500 printer and then click Next.
   Note: When installing drivers for a network printer and you do not see your printer in the list, click the IP Address or DNS Name button. In the IP Address or DNS Name field, type the IP address of your printer, then click Search to locate your printer. If you do not have the IP address of the printer, see Finding the IP Address of Your Printer on page 35.
5. In the Installation Options screen, select PostScript and/or PCL 6.
   Note: You can install both drivers at once. Each will be displayed in your printer list after installation.
6. Click Install to start the installation.
7. When the installation is complete, at the Installation Status screen, select the following:
   - Set Printer As Default (optional)
   - Print a Test Page
   - Share Printer (optional)
8. Click Finish.
9. At the Product Registration screen, select your country from the list and then click Next. Complete the registration form and submit it.
   If you selected to print a test page, the printer prints a test page for each driver you installed.
   Note: PrintingScout is a separate option from the print driver that monitors printer status. To install PrintingScout, go to Installing PrintingScout on page 40.

See also:
Online Support Assistant at www.xerox.com/office/6500support

Installing the Print Driver for Macintosh OS X

The installation process for Macintosh OS X is the same for versions 10.5 and later.

To install the print driver from the Software and Documentation disc:
1. Insert the Software and Documentation disc into the appropriate disc drive on your computer.
2. On your desktop, double-click the Phaser 6500 icon.
3. Click Phaser 6500 Installer.
4. If prompted to enter your password, do so and then click OK.
5. At the Introduction installer window, click Continue.
6. Read the license agreement, click Continue, and then click **Agree**.
7. Click **Install**.  
   When the driver is finished installing, your browser opens to an online registration form.
8. Complete the online registration and then close the browser.
9. At the Finish Up window, click **Quit**.
10. Next, add the printer to your printer queue. For details, see Adding the Printer for Macintosh OS X Version 10.5 and Later on page 39.

**Adding the Printer for Macintosh OS X Version 10.5 and Later**

For networking, set up your printer using Bonjour (Rendezvous), or connect using the IP address of your printer for an LPD/LPR connection. For a non-network printer, create a desktop USB connection.

**To Add the Printer**

1. From the **Applications** folder or from the dock, open **System Preferences**.
2. Open **Print & Fax**. The list of printers appears on the left of the window.
3. Click the plus (+) button under the list of printers.
4. Click the **Default** icon at the top of the window.
5. Select your printer from the list and click **Add**.
   
   **Note:** If your printer was not detected, verify that the printer is on and that the Ethernet or USB cable is connected properly.

**See also:**

Online Support Assistant at [www.xerox.com/office/6500support](http://www.xerox.com/office/6500support)
Installing PrintingScout

PrintingScout is a Windows utility that enables you to monitor the status of print jobs and printer supplies from your computer. It automatically checks the printer status when you send a print job. If the printer is unable to print, PrintingScout displays an alert on your computer screen to let you know that the printer needs attention.

To install PrintingScout:
1. Insert the Software and Documentation disc into the appropriate drive on your computer. If the installer does not start automatically, navigate to the drive and double-click the Setup.exe installer file.
2. At the installer screen, click Install PrintingScout.
3. In the Choose Setup Language window, select your language and then click Next.
4. At the Xerox® PrintingScout screen, click Next.
5. Read the license agreement and then click I accept the terms of the license agreement. Click Next.
6. At the next screen, accept the default installation destination by clicking Next.
7. Click Next.
8. Click Finish.

The PrintingScout icon appears on the right in your Windows Taskbar.

See also:
Checking Printer Status with PrintingScout on page 111
Enabling Optional Features

This section includes:
- Enabling Optional Features for the Windows PostScript Driver on page 41
- Enabling Optional Features for Macintosh OS X 10.5 and Later on page 43
- Enabling Optional Features for Linux on page 43

If your printer includes the duplex unit, 250-sheet feeder, RAM Disk, or extra memory, you must enable them in each print driver before you can use them.

Enabling Optional Features for the Windows PostScript Driver

This section includes:
- Enabling Optional Features for a Network-Connected Printer on page 41
- Enabling Optional Features for a USB Connected Printer on page 41

Enabling Optional Features for a Network-Connected Printer

1. Navigate to the list of printers on your computer:
   • For Windows XP SP1 and later, click Start > Settings > Printers and Faxes.
   • For Windows Vista, click Start > Control Panel > Hardware and Sound > Printers.
   • For Windows Server 2003 and later, click Start > Settings > Printers.
   • For Windows 7, click Start > Devices and Printers.
2. In the list of printers, right-click the Phaser 6500 PS printer and select Properties.
3. Click the Configuration tab and then click the Get Information from Printer button.
   The IP address of the printer appears in the Network Address section.
4. Click Apply.
5. To verify that the installed optional features are enabled, click the Device Settings tab and then scroll down to view the Installable Options section.
6. Click OK to close the Properties dialog box.

Enabling Optional Features for a USB Connected Printer

1. Navigate to the list of printers on your computer:
   • For Windows XP SP1 and later, click Start > Settings > Printers and Faxes.
   • For Windows Vista, click Start > Control Panel > Hardware and Sound > Printers.
   • For Windows Server 2003 and later, click Start > Settings > Printers.
   • For Windows 7, click Start > Devices and Printers.
2. In the list of printers, right-click the Phaser 6500 PS printer and select Properties.
3. In the Properties dialog box, click the Device Settings tab.
4. Click the plus sign (+) to the left of Installable Options to expand and see the list of optional features.
Installation and Setup

5. Enable the installed features:
   • To specify the amount of RAM memory available, click Memory and then select the amount of memory from the drop-down list.
   • To enable the 250-sheet feeder, click Paper Tray Configuration and select 2-Tray from the drop-down list.
   • If you have the Productivity Kit installed, enable the RAM Disk feature. Click RAM Disk and select Available from the list.
   • To enable the duplex unit, click Duplex Unit and select Available from the drop-down list.

6. Click OK.

Enabling Optional Features for the Windows PCL Driver

This section includes:
   • Enabling Optional Features for a Network-Connected Printer on page 41
   • Enabling Optional Features for a USB Connected Printer on page 41

Enabling Optional Features for a Network-Connected Printer

1. Navigate to the list of printers on your computer:
   • For Windows XP SP1 and later, click Start > Settings > Printers and Faxes.
   • For Windows Vista, click Start > Control Panel > Hardware and Sound > Printers.
   • For Windows Server 2003 and later, click Start > Settings > Printers.
   • For Windows 7, click Start > Devices and Printers.

2. In the list of printers, right-click the Phaser 6500 PCL printer and select Properties.

3. In the Properties dialog box, click the Options tab.

4. Click the Get Information from Printer button.
   The IP address of the printer appears in the Network Address section. The installed optional features appear as Available in the Items list. The amount of memory installed appears in the Memory Capacity field.

5. Click OK.

Enabling Optional Features for a USB Cable-Connected Printer

1. Navigate to the list of printers on your computer:
   • For Windows XP SP1 and later, click Start > Settings > Printers and Faxes.
   • For Windows Vista, click Start > Control Panel > Hardware and Sound > Printers.
   • For Windows Server 2003 and later, click Start > Settings > Printers.
   • For Windows 7, click Start > Devices and Printers.

2. In the list of printers, right-click the Phaser 6500 PCL printer and select Properties.

3. In the Properties dialog box, click the Options tab.
   The Items box lists the printer options. To the right of each item is the status, either Available or Not Available or, for Memory Capacity, the amount of RAM in MB.
4. To enable the items that are installed in your printer, select the item in the list and then, in the Settings for drop-down list, select **Available**. If you are enabling the Productivity Kit, then in Memory Capacity, select the amount of RAM in MB from the list.
5. Click **OK**.

**Enabling Optional Features for Macintosh OS X 10.5 and Later**

1. From the **Applications** folder or from the dock, open **System Preferences**.
2. Open **Print & Fax**. The list of printers appears on the left of the window.
3. Select your printer in the list and then click the **Options & Supplies** button.
4. In the window, click the **Driver** tab and select the print driver from the Print Using list.
5. Enable the installed features:
   - To specify the amount of RAM memory available, select the amount of memory from the drop-down Memory Capacity list.
   - To enable the optional 250-sheet feeder, click **Paper Tray Configuration** and select **2-Tray** from the drop-down list.
   - If you have the Productivity Kit installed, enable the RAM Disk feature. Select **Available** from the RAM Disk drop-down list.
   - To enable the duplex unit, select **Available** from the Duplex Unit drop-down list.
6. Click **OK**.

**Enabling Optional Features for Linux**

**Note:** These instructions are for using Common Linux Printing System (CUPS), accessed through a Web browser.

1. Open the Web browser on your computer. In the address field, type `http://127.0.0.1:631` and then press **Enter**.
2. At the CUPS Home tab, click the **Manage Printers** button.
3. Locate your printer in the list and then click the **Set Printer Options** button for your printer.
4. At the Set Printer Options page, enable the optional features installed on your printer:
   - In the Memory field, select the amount of Memory in MB.
   - If you have the 250-sheet feeder installed, select **2-Tray** in the Paper Tray Configuration field.
   - To enable RAM Disk (Productivity Kit required), select the **Available** option.
   - To enable automatic 2-sided printing, at the Duplex Unit field, select the **Available** option.
5. Click **Set Printer Options** to save the settings.
This chapter includes:

- Supported Paper and Media on page 46
- Loading Paper on page 51
- Setting Paper Types and Sizes on page 58
- Selecting Printing Options on page 60
- Printing on Specialty Media on page 68
- Printing Custom Sizes on page 78
- Printing on Both Sides of the Paper on page 81
- Printing Using Secure Print on page 84
- Printing Using Proof Print on page 87
Supported Paper and Media

This section includes:
- Paper Usage Guidelines on page 46
- Paper That Can Damage Your Printer on page 47
- Paper Storage Guidelines on page 47
- Supported Paper on page 48

Your printer is used with various paper types. Follow the guidelines in this section to ensure the best print quality and to avoid jams.

For best results, use Xerox® printing media specified for your printer. They are guaranteed to produce excellent results with your printer.

To order paper or other specialty media, contact your local reseller or go to www.xerox.com/office/6500supplies.

CAUTION: the Xerox® Warranty, Service Agreement, or Total Satisfaction Guarantee do not cover damage caused by using unsupported paper, transparencies, and other specialty media. The Total Satisfaction Guarantee is available in the United States and Canada. Coverage can vary outside these areas. Please contact your local representative for details.

See also:
- Recommended Media List (Europe): www.xerox.com/europaper
- Recommended Media List (North America): www.xerox.com/paper

Paper Usage Guidelines

Each printer tray accommodates certain sizes and types of paper or other specialty media. Follow these guidelines when loading paper in the trays:
- Fan paper before loading it in the tray.
- Do not print on label stock once a label has been removed from a sheet.
- Use only paper envelopes. Do not use envelopes with windows, metal clasps, or adhesives with release strips.
- Print all envelopes 1-sided only.
- Some wrinkling and embossing can occur when printing envelopes.
- Do not overload the paper trays. Do not load paper above the fill line on the inside of the paper guide.
- Adjust the paper guides to fit the paper size. The paper guides click into place when they are adjusted correctly.
- If excessive jams occur, use paper or other media from a new package.
Paper That Can Damage Your Printer

Your printer is designed to use various paper types. However, some paper can cause poor output quality, increase paper jams, or damage your printer.

Unacceptable media includes:
- Rough or porous media
- Transparencies
- Paper that has been folded or wrinkled
- Paper with staples
- Envelopes with windows or metal clasps
- Padded envelopes
- Non-laser glossy or coated paper
- Perforated media
- Carbon backed media or paper
- Pressure sensitive media or paper
- Paper designed for use in inkjet printers

Paper Storage Guidelines

Providing good storage conditions for your paper contributes to optimum print quality.
- Store paper in dark, cool, relatively dry locations. Most paper items are susceptible to damage from ultraviolet (UV) and visible light. UV radiation emitted by the sun and fluorescent bulbs is particularly damaging to paper items. Reduce the intensity and length of exposure to visible light on paper items as much as possible.
- Maintain constant temperatures and relative humidity.
- Avoid moisture, excessive humidity, and heat above 32°C (90°F).
- Avoid attics, kitchens, garages, and basements for storing paper. Inside walls are drier than outside walls where moisture can collect.
- Store paper flat on pallets, cartons, shelves, or in cabinets.
- Avoid having food or drinks in the area where paper is stored or handled.
- Do not open sealed packages of paper until you are ready to load them into the printer. Leave paper in the original packaging. For most commercial cut-size grades, the ream wrapper contains an inner lining that protects the paper from moisture loss or gain.
Using unsuitable paper can lead to paper jams, poor print quality, and damage to your printer. To use the features of the printer effectively, use the paper recommended in the following tables.

Printing on paper that has settings different from the paper size or paper type selected in the print driver can lead to paper jams. Loading paper into a paper tray unsuitable for the type of print job can also lead to paper jams. To ensure that printing is done correctly, select the correct paper size, paper type, and paper tray.

The printed image can fade due to moisture, such as water, rain or vapor. For details, contact your reseller.

### Tray 1

| Paper Size                          | • Letter (8.5 x 11 in.)  
|                                    | • US Folio (8.5 x 13 in.)  
|                                    | • Legal (8.5 x 14 in.)     
|                                    | • Executive (7.25 x 10.5 in.)  
|                                    | • A4 (210 x 297 mm, 8.2 x 11.5 in.)  
|                                    | • A5 (148 x 210 mm, 5.2 x 8.2 in.)  
|                                    | • JIS B5 (182 x 257 mm)     
|                                    | • #10 Envelope (4.1 x 9.5 in.)  
|                                    | • Monarch Envelope (3.9 x 7.5 in.)  
|                                    | • DL Envelope (110 x 220 mm)  
|                                    | • C5 Envelope (162 x 229 mm)  
|                                    | • Custom size range:  
|                                    |   Width: 3–8.5 in. (76.2–215.9 mm)  
|                                    |   Height: 5–14 in. (127–355.6 mm)  
| Paper Type and Weight             | • Plain (65–120 g/m², 17–32 lb. Bond)  
|                                    | • Lightweight Cardstock (100–163 g/m², 37–60 lb. Cover)  
|                                    | • Heavyweight Cardstock (163–220 g/m², 60–80 lb. Cover)  
|                                    | • Envelope  
|                                    | • Labels  
|                                    | • Letterhead  
|                                    | • Lightweight Glossy Cardstock (100–163 g/m², 37–60 lb. Cover)  
|                                    | • Heavyweight Glossy Cardstock (163–220 g/m², 60–80 lb. Cover)  
|                                    | • Hole Punched  
|                                    | • Colored Paper  
|                                    | • Special  
| Loading Capacity                  | 250 sheets (20 lb.)  

## 250-Sheet Feeder (Tray 2)

<table>
<thead>
<tr>
<th>Paper Size</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Letter (8.5 x 11 in.)</td>
</tr>
<tr>
<td></td>
<td>• US Folio (8.5 x 13 in.)</td>
</tr>
<tr>
<td></td>
<td>• Legal (8.5 x 14 in.)</td>
</tr>
<tr>
<td></td>
<td>• Executive (7.25 x 10.5 in.)</td>
</tr>
<tr>
<td></td>
<td>• A4 (210 x 297 mm)</td>
</tr>
<tr>
<td></td>
<td>• A5 (148 x 210 mm)</td>
</tr>
<tr>
<td></td>
<td>• JIS B5 (182 x 257 mm)</td>
</tr>
<tr>
<td></td>
<td>• Custom size range:</td>
</tr>
<tr>
<td></td>
<td>Width: 5.8–8.5 in. (147.3–215.9 mm)</td>
</tr>
<tr>
<td></td>
<td>Height: 8.3–14 in. (210.8–355.6 mm)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Paper Type and Weight</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Plain Paper (60–105 g/m², 16–28 lb. Bond)</td>
</tr>
<tr>
<td></td>
<td>• Letterhead</td>
</tr>
<tr>
<td></td>
<td>• Hole Punched</td>
</tr>
<tr>
<td></td>
<td>• Colored Paper</td>
</tr>
</tbody>
</table>

| Loading Capacity      | 250 sheets (20 lb.)                                            |

## Manual Feed Slot

<table>
<thead>
<tr>
<th>Paper Size</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Letter (8.5 x 11 in.)</td>
</tr>
<tr>
<td></td>
<td>• Legal (8.5 x 14 in.)</td>
</tr>
<tr>
<td></td>
<td>• Executive (7.25 x 10.5 in.)</td>
</tr>
<tr>
<td></td>
<td>• US Folio (8.5 x 13 in.)</td>
</tr>
<tr>
<td></td>
<td>• No. 10 Envelope (4.1 x 9.5 in.)</td>
</tr>
<tr>
<td></td>
<td>• Monarch Envelope (3.9 x 7.5 in.)</td>
</tr>
<tr>
<td></td>
<td>• DL Envelope (110 x 220 mm)</td>
</tr>
<tr>
<td></td>
<td>• C5 Envelope (162 x 229 mm)</td>
</tr>
<tr>
<td></td>
<td>• A4 (210 x 297 mm)</td>
</tr>
<tr>
<td></td>
<td>• A5 (148 x 210 mm)</td>
</tr>
<tr>
<td></td>
<td>• JIS B5 (182 x 257 mm)</td>
</tr>
<tr>
<td></td>
<td>• Custom size range:</td>
</tr>
<tr>
<td></td>
<td>Width: 3–8.5 in. (76.2–215.9 mm)</td>
</tr>
<tr>
<td></td>
<td>Height: 5–14 in. (127–355.6 mm)</td>
</tr>
</tbody>
</table>
## Manual Feed Slot

<table>
<thead>
<tr>
<th>Paper Type and Weight</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain (65–120 g/m², 17–32 lb. Bond)</td>
<td>Plain paper</td>
</tr>
<tr>
<td>Letterhead (plain)</td>
<td>Letterhead paper</td>
</tr>
<tr>
<td>Lightweight Cardstock (100–163 g/m², 28–60 lb. Cover)</td>
<td>Lightweight Cardstock</td>
</tr>
<tr>
<td>Heavyweight Cardstock (163–220 g/m², 60–80 lb. Cover)</td>
<td>Heavyweight Cardstock</td>
</tr>
<tr>
<td>Lightweight Glossy Cardstock (100–163 g/m², 28–60 lb. Cover)</td>
<td>Lightweight Glossy Cardstock</td>
</tr>
<tr>
<td>Heavyweight Glossy Cardstock (163–200 g/m², 60–80 lb. Cover)</td>
<td>Heavyweight Glossy Cardstock</td>
</tr>
<tr>
<td>Hole Punched (plain)</td>
<td>Hole Punched paper</td>
</tr>
<tr>
<td>Colored Paper (plain)</td>
<td>Colored paper</td>
</tr>
<tr>
<td>Labels</td>
<td>Labels</td>
</tr>
<tr>
<td>Envelope (short-edge feed only for Monarch and DL envelopes)</td>
<td>Envelope paper</td>
</tr>
<tr>
<td>Special</td>
<td>Special paper</td>
</tr>
</tbody>
</table>

| Loading Capacity | One sheet at a time |

## Duplex Unit (2-Sided Printing)

<table>
<thead>
<tr>
<th>Paper Size</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A4 (210 x 297 mm)</td>
<td>A4 paper</td>
</tr>
<tr>
<td>Letter (8.5 x 11 in.)</td>
<td>Letter paper</td>
</tr>
<tr>
<td>US Folio (8.5 x 13 in.)</td>
<td>US Folio paper</td>
</tr>
<tr>
<td>Legal (8.5 x 14 in.)</td>
<td>Legal paper</td>
</tr>
<tr>
<td>Custom size range: Width: 3–8.5 in. (76.2–215.9 mm) Height: 5–14 in. (127–355.6 mm)</td>
<td>Custom size paper</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Paper Type and Weight</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain (60–105 g/m², 16–28 lb. Bond)</td>
<td>Plain paper</td>
</tr>
<tr>
<td>Letterhead (plain)</td>
<td>Letterhead paper</td>
</tr>
<tr>
<td>Hole Punched (plain)</td>
<td>Hole Punched paper</td>
</tr>
<tr>
<td>Colored paper (plain)</td>
<td>Colored paper</td>
</tr>
</tbody>
</table>

| Loading Capacity | One sheet at a time |
Loading Paper

This section includes:
- Loading Paper in Tray 1 on page 51
- Loading Paper in the Manual Feed Slot on page 53
- Loading Paper in the 250-Sheet Feeder (Tray 2) on page 55

Loading Paper in Tray 1

You can use Tray 1 for a wide variety of media, including:
- Plain Paper
- Lightweight Cardstock
- Heavyweight Cardstock
- Letterhead
- Labels
- Envelopes
- Lightweight Glossy Cardstock
- Heavyweight Glossy Cardstock
- Hole Punched
- Colored Paper
- Pre-printed Paper (paper already printed on one side)
- Custom size Paper

For a complete list of paper types and sizes usable in Tray 1, see Supported Paper on page 48.

Follow these guidelines when loading paper into Tray 1:
- Load up to 250 sheets of plain paper or a stack of paper (65–220 g/m², 17–40 lb. Bond, 40–80 lb. Cover) less than 15 mm high (0.60 in.).
- Tray 1 accepts paper within the following dimensions:
  - Width: 76.2–216 mm (3–8.5 in.)
  - Length: 127–355.6 mm (5–14 in.)
  - For automatic 2-sided printing, you can load paper in the range of 60–105 g/m² (16–28 lb. Bond).
- Do not load different types of paper in the same tray at the same time.
- To print high quality, use high-quality paper intended for laser printers.
- Do not remove or add paper to Tray 1 during printing. Doing so could cause a paper jam. Remove the paper, align it with the new paper and insert both into the tray together.
- Do not put any objects other than paper on Tray 1.
- Do not push or force down Tray 1.
- Always load paper short-edge feed first.

For more paper usage guidelines, see Supported Paper and Media on page 46.
Printing

To load paper in Tray 1:

1. Gently pull the paper tray all the way out and then open the output tray to hold the printed sheets.

2. Slide the paper width guides to the edge of the tray. Extend the width guides fully as shown in the following illustration.

3. Before loading the paper flex the sheets back and forth, and then fan them. Straighten the edges of the stack on a level surface.
4. Insert all paper face up and top edge at the front of the paper tray.

   **Notes:**
   - Do not force the paper into the tray.
   - Be careful not to bend the paper.

5. Slide the paper width guides until they rest lightly against the edge of the paper stack.

6. Insert the tray back into the printer until it stops.

   **CAUTION:** Be careful not to use excessive force on the tray. Doing so could damage the printer.

---

See also:

*Setting Paper Types and Sizes* on page 58

---

**Loading Paper in the Manual Feed Slot**

Use the manual feed slot for a wide range of media including:

- Plain Paper
- Letterhead
- Lightweight Cardstock
- Heavyweight Cardstock
- Lightweight Glossy Cardstock (Coated 2 and Coated 3)
- Heavyweight Glossy Cardstock
- Colored Paper
- Labels
- Envelopes
- Special

For a more complete list of paper types and sizes usable in the Manual Feed Slot, see *Supported Paper* on page 48.

To avoid problems during printing, follow these guidelines:

- Use several sheets of the paper only when adjusting the paper width guides.
- Holding the paper on both sides, slowly and evenly insert the paper into the printer.
- If the paper looks skewed after the printer pulls it in, gently remove the paper and reseat it. Then press the **OK** button or wait for the automatic calibration to start.
To load paper in the manual feed slot:

1. Slide the paper guides of the manual feed slot to fit the paper you are using.

2. Open the output tray to hold the printed sheets.

3. Place the paper into the slot with the print side face down and the top of the sheet entering the printer first.

   Note: You can insert paper during the ready mode or sleep mode of the printer. The printer automatically detects the paper and holds it while it waits for a print job.
Loading Paper in the 250-Sheet Feeder (Tray 2)

You can use the 250-sheet feeder for the following types of paper:

- Plain paper
- Letterhead
- Hole Punched
- Colored Paper

For supported paper sizes and weights, see Supported Paper on page 48.

Follow these guidelines to avoid problems during printing:

- Do not load different types of paper in the tray at the same time.
- To print high quality, use high-quality paper intended for laser printers.
- Do not remove or add paper to the 250-sheet feeder during printing. Doing so can cause a paper jam. Remove the paper, align it with the new paper, and insert both into the tray together.
- Do not put any objects other than paper on the tray.
- Do not push or force down the tray.
- Always load paper short-edge feed first.

**CAUTION:** Do not remove the tray during printing because it can cause a paper jam.

To load paper in the 250-sheet feeder:

1. Gently pull the paper tray out of the printer.

2. Open the output tray to hold the printed sheets.

3. Slide the paper width guides to the edge of the tray. Extend the width guides fully as shown in the following illustration.
4. Squeeze the green tab on the length guide and then slide the tray until the arrow lines up with the appropriate paper size. The guide clicks into place.

5. Before loading the paper, flex the sheets back and forth, and then fan them. Straighten the edges of the stack on a level surface.

6. Place the paper into the tray with the print side face up.
   
   **Note:** Do not exceed the maximum fill line in the tray. Overfilling the tray can cause paper jams.

7. Slide the width and length guides until they rest lightly against the edge of the paper stack.
   
   **Note:** Be careful not to bend the paper.
8. Insert the tray back into the printer until it stops.

   **CAUTION:** Be careful not to use excessive force on the tray. Doing so could damage the printer.

*See also:*
   Setting Paper Types and Sizes on page 58
Setting Paper Types and Sizes

This section includes:

- Setting the Paper Type on page 58
- Setting the Paper Size on page 58

After loading paper in paper Tray 1 or the 250-sheet feeder (Tray 2), set the paper type on the printer control panel.

**Notes:**

- If None is selected in the Paper Type menu in the print driver, the printer uses the control panel settings. The printer prints only when the settings for the paper size and type configured in the print driver match the control panel settings. If the settings in the print driver and control panel do not match, follow the instructions displayed on the control panel.
- You can select to display a message prompting you to set the paper size and type on the control panel each time paper is loaded. For details, see Tray Settings Menu on page 102.

### Setting the Paper Type

**CAUTION:** Paper type settings must match the type of paper loaded in the tray, or print-quality problems can occur.

**Note:** If None is selected in the Paper Type menu in the print driver, the printer uses the control panel settings. The printer prints only when the settings for the paper size and type configured in the print driver match the control panel settings. If the settings in the print driver and control panel do not match, the setting in the print driver will override the setting on the control panel for this job.

To set the paper type for paper in a tray:

1. On the printer control panel, press the **Menu** button.
2. Press the **Down Arrow** button to go to **Tray Settings** and then press the **OK** button.
3. Press the **Down Arrow** button to scroll to the tray you are setting and then press **OK**.
4. At **Paper Type**, press **OK**.
5. Press the **Down Arrow** button to scroll to the type of paper that is loaded in the tray. Press **OK**.
6. Press the **Return button** when you are finished.

### Setting the Paper Size

To set the paper size for paper in a tray:

1. On the printer control panel, press the **Menu** button.
2. Press the **Down Arrow** button to go to **Tray Settings** and then press the **OK** button.
3. Press the **Down Arrow** button to scroll to the tray you are setting and then press **OK**.
4. Press the **Down Arrow** button to scroll to **Paper Size** and press the **OK** button.
5. Select the paper size and then press OK.
6. Press the Return button when finished.
Selecting Printing Options

This section includes:

- Selecting Printing Defaults in Windows on page 60
- Selecting Printing Defaults in Windows for a Shared Network Printer on page 61
- Selecting Printing Options for an Individual Job in Windows on page 61
- Selecting Printing Options for an Individual Job in Macintosh on page 65

Note: Print driver settings override control panel settings when you print using the driver software on your computer.

Selecting Printing Defaults in Windows

Notes:

- These instructions are for setting print driver defaults for the print driver software installed on your computer. You can set defaults settings for a network printer that apply to that printer for anyone who accesses it over the network. For details, see Selecting Printing Defaults in Windows for a Shared Network Printer on page 61.

- Use the following procedure to set the default settings used for all print jobs sent to the printer from your computer using the specific driver. You can override the default settings for an individual print job when printing from an application.

1. Navigate to the list of printers on your computer:
   - For Windows XP SP1 or later, click Start > Settings > Printers and Faxes.
   - For Windows Vista, click Start > Control Panel > Hardware and Sound > Printers.
   - For Windows 7, click Start > Devices and Printers.
2. In the Printers folder, right-click the name of your print driver (printer name plus PCL 6 or PS) and select Printing Preferences.
3. Make selections on the driver tabs as desired and then click OK to save your selections.
4. Set defaults for the other print driver if applicable.

Note: For more information about Windows print driver options, click the Help button in the Printing Preferences dialog box to view the online help.
Selecting Printing Defaults in Windows for a Shared Network Printer

If the printer is shared on a network, you can set printing defaults that apply to anyone who accesses it from the network. You can override network-level defaults through the driver settings on an individual computer.

1. Navigate to the list of printers on your computer:
   - For Windows XP SP1 or later, click Start > Settings > Printers and Faxes.
   - For Windows Vista, click Start > Control Panel > Hardware and Sound > Printers.
   - For Windows 7, click Start > Devices and Printers.
2. In the Printers folder, right-click the name of your print driver (printer name plus PCL 6 or PS) and select Properties.
3. In the printer Properties dialog box, click the Advanced tab.
4. In the Advanced tab, click the Printing Defaults button.
5. Make selections on the driver tabs as desired and then click Apply to apply your selections.
6. Click OK to save your selections.

Selecting Printing Options for an Individual Job in Windows

This section includes:
- Printing Options for Windows PostScript Driver on page 62
- Printing Options for Windows PCL Driver on page 63

To use special printing options for a particular job, change the print driver settings in the application before sending the job to the printer.

**Note:** The print driver includes online help with more information on selecting printing options. In the driver dialog boxes, click the Help button.

To select printing options:
1. With the desired document or graphic open in your application, open the Print dialog box.
2. Select your printer (either PostScript or PCL) and then click the Properties button to open the print driver dialog box.

**Note:** In the PCL driver for Windows, you can save a set of printing options with a distinctive name and apply them to other print jobs. For instructions, click the Help button in the print driver dialog box to view the online help.
Printing Options for Windows PostScript Driver

For detailed information on using the print driver options, click the Help button in the print driver boxes to access the driver online help.

**Note:** For optional printer features to be available in the print driver, the optional features must be installed and enabled. If you have not enabled your installed optional features, see Enabling Optional Features on page 41.

<table>
<thead>
<tr>
<th>Driver Tab</th>
<th>Printing Option</th>
</tr>
</thead>
</table>
| Paper/Output     | • Job Type: Specifies the type of print job: Normal Print, Secure Print, Proof Print, and Proof Print available with extra RAM memory only.  
• 2-Sided Print: 1-Sided Print, Flip on long edge, Flip on short edge.  
• Paper Size: Specifies the size of the paper to print on, including specifying a custom paper size.  
• Paper Tray: Specifies which paper tray to print to when the Paper Tray setting in the PostScript print driver is set to Auto Select.  
• Paper Type: Specifies the type of paper in the tray.  
• Image Orientation: Portrait or Landscape.  
• Output Color: Color or Black and White.  
• Saved Settings: Enables you to save the current settings under a specific name so that they can be used repeatedly. Also enables you to load and edit a set of saved settings.  
• Printer Status button: Opens the internal settings page of the printer in CentreWare Internet Services, in your computer Web browser for network printers only.  
• Defaults button: Returns all of the Paper/Output tab settings to their defaults.  
• Default All button: Returns all settings in the Properties dialog of the printer to their defaults.  
• Help button: Opens the online help of the print driver for the Paper/Output tab. |
| Image Options    | • Image Quality: Affects the quality of the print by specifying the speed at which the page prints.  
• Brightness: Makes the printed image or page darker or lighter.  
• Color Correction: Specifies how color is applied to printed images, text, and photographs.  
• Color Balance button: Enables you to specify the density of each color used for printing.  
• Defaults button: Returns all of the Image Options tab settings to their defaults.  
• Help button: Opens the online help of the print driver for the Image Options tab. |
### Printing Options for Windows PCL Driver

For detailed information on using the print driver options, click the **Help** button in the print driver to access the online help.

**Note:** For optional printer features to be available in the print driver, the optional features must be installed and enabled. If you have not enabled your installed optional features, see **Enabling Optional Features** on page 41.

<table>
<thead>
<tr>
<th>Driver Tab</th>
<th>Printing Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Layout</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Pages per Sheet (N-up): For multiple-page documents, enables you to print more than one page per sheet of paper, including Booklet print.</td>
</tr>
<tr>
<td></td>
<td>• Draw Outlines: When multiple pages are printed per sheet, prints a border around each page.</td>
</tr>
<tr>
<td></td>
<td>• Fit to New Paper Size: Select the output paper size to fit the page to.</td>
</tr>
<tr>
<td></td>
<td>• Defaults button: Returns all of the Layout tab settings to their defaults.</td>
</tr>
<tr>
<td></td>
<td>• Help button: Opens the online help of the print driver for the Layout tab.</td>
</tr>
<tr>
<td>Advanced</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Image Options: Enables you to set print resolution, image color management and method used, TrueType font configuration, and image magnification or reduction percentage for printed images.</td>
</tr>
<tr>
<td></td>
<td>• Document Options: Enables you to set the PostScript Options and the Manual Feed slot Orientation. PostScript Options include the PostScript Output Format, TrueType Font Download Method, PostScript Language Level, PostScript Error Message control, and Mirror Image control.</td>
</tr>
<tr>
<td></td>
<td>• Help button: Opens the online help of the print driver for the Advanced tab.</td>
</tr>
<tr>
<td></td>
<td>• Set Features to Default button: Returns all of the Advanced tab settings to their defaults.</td>
</tr>
</tbody>
</table>
### Paper/Output

- **Job Type**: Specifies the type of print job: Normal Print, Secure Print, Proof Print. Secure Print and Proof Print are available with extra RAM memory only.
- **2-Sided Print**: 1-Sided Print, Flip on long edge, Flip on short edge.
- **Paper Size**: Specifies the size of the paper to print on, including specifying a custom paper size.
- **Output Color**: Color or Black and White.
- **Paper Type**: Specifies the type of paper in the tray.
- **Saved Settings**: Enables you to save the current settings under a specific name so that they can be used repeatedly. Also enables you to load and edit a set of saved settings.
- **Paper Tray**: Specifies which paper tray to print to when the Paper Tray setting in the PCL driver is set to Auto Select.
- **Manual Feed Slot Orientation**: Portrait or Landscape.
- **Covers/Separators button**: Enables you to specify cover and separator pages for print jobs.
- **Printer Status button**: Opens the internal settings page of the printer in CentreWare Internet Services, in your computer Web browser (network printers only).
- **Defaults button**: Returns all of the Paper/Output tab settings to their defaults.

### Image Options

- **Image Quality**: Affects the print quality by specifying way the image is processed and marked on the page.
- **Output Color**: Specifies Color or Black and White.
- **Output Recognition**: When Color is selected in the Output Color field, selecting this check box causes some chromatic colors to be printed as black.
- **Image Adjustment Mode**: Recommended, ICM Adjustment (System), CMS Adjustment (Application), Complementary Color Conversion.
- **Image Types**: Enables you to specify a printing mode to match the characteristics of the printed image.
- **Image Auto Correction**: Determines the characteristics of a specified image type, such as photographs on a page, and automatically performs correction for it.
- **Image Settings button**: Opens the Image Settings tab of the Graphics Properties dialog box.
- **Color Balance button**: Opens the Color Balance tab of the Graphics Properties dialog box.
- **Profile Settings button**: Opens the Profile Settings tab of the Graphics Properties dialog box.
- **Defaults button**: Returns all of the Image Option tab settings to their defaults.
Selecting Printing Options for an Individual Job in Macintosh

To use special printing options for a particular job, change the print driver settings in the application before sending the job to the printer.

Note: The print driver includes help with more information on selecting printing options.

1. With the document open in your application, click File and then click Print.
2. Select the desired printing options from the menus and drop-down lists that are displayed. For a list of options, see Printing Options for Macintosh OS X Version 10.5 or Later on page 65.

   Note: In Macintosh OS X, click Save from the Presets drop-down list on the Print menu screen to save the current printer settings. You can create multiple presets and save each with its own distinctive name and printer settings. To print jobs using specific printer settings, select the applicable saved preset in the Presets list.

3. Click Print to print the job.

Printing Options for Macintosh OS X Version 10.5 or Later

For detailed information on using the print driver options, click the question mark (?) button in the print driver to access the online help.
<table>
<thead>
<tr>
<th>Driver Drop-Down Title</th>
<th>Printing Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copies &amp; Pages</td>
<td>- Copies: Specifies number of copies and whether to collate.</td>
</tr>
<tr>
<td></td>
<td>- Pages: All, Current, Selection, From x to x, Page range.</td>
</tr>
<tr>
<td>Layout</td>
<td>- Pages per Sheet: Specifies the number of pages to print on each sheet of paper.</td>
</tr>
<tr>
<td></td>
<td>- Layout Direction: Specifies the order in which to print the pages when printing multiple pages on one sheet of paper.</td>
</tr>
<tr>
<td></td>
<td>- Border: Specifies the type and width of border to print around each page printed on the sheet of paper.</td>
</tr>
<tr>
<td></td>
<td>- Two-Sided: When selected, specifies whether to flip the page on the long edge or the short edge (duplex unit required).</td>
</tr>
<tr>
<td>Color Matching</td>
<td>- ColorSync: This selection allows you to choose a profile from the Profile selection menu.</td>
</tr>
<tr>
<td></td>
<td>- In printer</td>
</tr>
<tr>
<td>Paper Handling</td>
<td>- Pages To Print: All Pages, Odd Only, Even Only.</td>
</tr>
<tr>
<td></td>
<td>- Destination paper size: (Active only when Scale to fit paper size is selected.) Specifies the paper size to print to.</td>
</tr>
<tr>
<td></td>
<td>- Page Order: Automatic, Normal, Reverse.</td>
</tr>
<tr>
<td>Paper Feed</td>
<td>- All pages from: Specifies the tray to print all pages from: Auto Select, Manual Feed Slot, Tray 1, Tray 2 (if installed).</td>
</tr>
<tr>
<td></td>
<td>- First page from: Specifies the tray from which to print the first page.</td>
</tr>
<tr>
<td></td>
<td>- Remaining from: Specifies the tray from which to print the remaining pages.</td>
</tr>
<tr>
<td>Cover Page</td>
<td>- Print Cover Page: None, Before document, After document.</td>
</tr>
<tr>
<td></td>
<td>When an option other than None is selected, a cover page prints.</td>
</tr>
<tr>
<td></td>
<td>- Cover Page Type: Classified, Confidential, Secret, Standard, Top Secret, Unclassified.</td>
</tr>
<tr>
<td></td>
<td>- Billing Info: A field in which you can specify billing information to print on the cover page.</td>
</tr>
<tr>
<td>Scheduler</td>
<td>- Print Document: Now, At [time], On Hold.</td>
</tr>
<tr>
<td></td>
<td>- Priority: Urgent, High, Medium, Low.</td>
</tr>
<tr>
<td>Job Type</td>
<td>Specifies the type of print job: Normal Print, Secure Print, Proof Print. Secure Print and Proof Print are available with extra RAM memory only.</td>
</tr>
<tr>
<td>Job Control</td>
<td>- Account Mode: User, Administrator.</td>
</tr>
<tr>
<td></td>
<td>- User Settings: Specifies account settings such as name and password.</td>
</tr>
<tr>
<td>Driver Drop-Down Title</td>
<td>Printing Options</td>
</tr>
<tr>
<td>------------------------</td>
<td>------------------</td>
</tr>
</tbody>
</table>
| Printer Features       | • Print Quality/Color: Specifies output color, image quality, brightness, color correction method, halftone screen settings, and adjust color balance.  
• Color Adjustment: Specifies RGB color adjustment settings.  
• Color Balance (C, M, Y, K): Specifies amount of color to use.  
• Media Handling: Specifies manual feed slot orientation, paper type, size mismatch setting, and custom paper auto orientation.  
• Printer-specific Options: Image Enhancement, Draft Mode, Skip Blank Pages, Halftone Screen Lock, Faster B/W documents. |
| Supply Levels          | Displays bar graph showing level of toner left in each toner cartridge, and the useful life remaining of the Imaging Unit. |
| Summary                | Summarizes the driver selections. |
Printing on Specialty Media

This section includes:
- Printing Envelopes on page 68
- Printing Labels on page 71
- Printing on Glossy Cardstock on page 73
- Printing on Cardstock on page 76

Printing Envelopes

This section includes:
- Guidelines for Printing Envelope on page 68
- Printing Envelopes from Tray 1 on page 69
- Printing Envelopes from the Manual Feed Slot on page 70
- Printing Envelopes using the PostScript Driver on page 70
- Printing Envelopes using the PCL Driver on page 71

Guidelines for Printing Envelope

- Envelopes can be printed from Tray 1 and from the manual feed slot.
- Do not perform automatic 2-sided printing using envelopes.
- Successful envelope printing is highly dependent on the quality and construction of the envelopes. Use envelopes made specifically for laser printers, in the supported sizes. For a listing of supported envelope sizes for Tray 1 and the manual feed slot, see Supported Paper on page 48.
- Store unused envelopes in their packaging to avoid the effects of moisture and dryness, which can affect print quality and cause wrinkling. Excessive moisture can cause the envelopes to seal before or during printing. For best results, maintain constant temperatures and relative humidity.
- Do not use padded envelopes. Purchase envelopes that lie flat.
- Remove air bubbles from the envelopes before loading by setting a heavy book on top of the envelopes.
- If wrinkling or embossing problems occur, use a different brand of envelope made specifically for laser printers.

**CAUTION:** Never use envelopes with windows or metal clasps because they can damage the printer. Damage caused by using unsupported envelopes is not covered under the Xerox® Warranty, Service Agreement, or Total Satisfaction Guarantee. The Total Satisfaction Guarantee is available in the United States and Canada. Coverage can vary outside these areas. Please contact your local representative for details.
Printing Envelopes from Tray 1

To load envelopes:
1. Gently pull out the paper tray and then open the output tray to hold the printed envelopes. For details, see Loading Paper in Tray 1 on page 51.
2. Slide the paper guides to the edge of the tray.
3. Insert the envelopes with the flaps closed, flaps down, and flaps to the right. You can load envelopes up to the maximum fill line in the tray.
   
   **Note:** You cannot print on the reverse side of the envelope. Envelopes can get wrinkled or the print quality can be reduced, depending on the envelope type used.

4. Slide the paper guides so they rest lightly against the edges of the envelopes.
5. Insert the tray back into the printer until it stops.
6. On the printer control panel, press the **Menu** button to display the Menu screen.
7. Press the **Down Arrow** button to go to **Tray Settings** and then press the **OK** button.
8. At **Tray 1**, press **OK**.
9. At **Paper Type**, press **OK**.
10. At **Envelope**, press **OK**.
11. Press the **Return button** once to back out of the menu, then press the **Down Arrow** button to select **Paper Size**. Press **OK**.
12. Press the **Down Arrow** button to scroll the desired envelope size and then press **OK**.
13. Do one of the following:
   - If you are printing using the PostScript driver, go to Printing Envelopes using the PostScript Driver on page 70.
   - If you are printing using the PCL driver, go to Printing Envelopes using the PCL Driver on page 71.
Printing Envelopes from the Manual Feed Slot

Note: You can load only one envelope at a time in the manual feed slot.

To load an envelope:
1. Slide the paper guides of the manual feed slot to fit the envelopes you are using. Open the output tray to hold the printed envelopes. For details, see Loading Paper in the Manual Feed Slot on page 53.
2. Insert one envelope with the flaps closed, flaps up, and flaps to the right as shown in the illustration.
3. Slide the paper guides so they rest lightly against the edge of the envelope.
4. Do one of the following:
   - If you are printing using the PostScript driver, go to Printing Envelopes using the PostScript Driver on page 70.
   - If you are printing using the PCL driver, go to Printing Envelopes using the PCL Driver on page 71.

Printing Envelopes using the PostScript Driver

1. After loading the envelopes in the appropriate tray or the manual feed slot, in the application you are printing from, open the Print dialog.
2. Select the Phaser 6500 PostScript printer from the list of printers and then click the Properties (or Preferences) button.
3. In the Paper/Output tab, do the following:
   a. From the Paper Type list, select Envelope.
   b. From the Paper Size list, select the envelope size.
   c. From the Paper Tray list, select the tray you are using.
4. Click OK and then, in the Print dialog box, click OK (or Print) to start printing.
Printing Envelopes using the PCL Driver

1. After loading the envelopes in the appropriate tray, in the application you are printing from, open the Print dialog.
2. Select the Phaser 6500 PCL printer from the list of printers and then click the Properties (or Preferences) button.
3. In the Paper/Output tab, do the following:
   a. From the Paper Type list, select Envelope.
   b. From the Paper Size list, select the envelope size.
   c. From the Paper Tray list, select the tray you are using.
4. Select the Layout tab and then, from the Fit to New Paper Size list, select the envelope size.
   
   Note: Some applications do not allow you to rotate the image for printing on envelopes the way they are fed into the printer. Since you cannot change the way the envelope is fed into the printer, you can use the special rotation setting of the print driver. In the Layout tab, click the Booklet/Poster/Mixed Document/Rotati on button and select Portrait & Landscape [For envelopes] from the Image Rotation (180 deg) list and then click OK.
5. Click OK and then, in the Print dialog box, click OK (or Print) to start printing.

Printing Labels

This section includes:
• Guidelines for Printing Labels on page 71
• Printing Labels from Tray 1 on page 72
• Printing Labels from the Manual Feed Slot on page 72

To order paper or other specialty media, contact your local reseller or go to the Xerox® Supplies website at www.xerox.com/office/6500supplies.

Guidelines for Printing Labels

   Note: Labels can be printed from Tray 1 and from the manual feed slot.

• Do not use vinyl labels.
• Print only on one side of the sheet of labels. Use full sheet labels only.

   CAUTION: Do not use any sheet where labels are missing; it can damage the printer.

• Do not use labels that are perforated, have backing sheets that have partially peeled away or that have parts of the labels already removed.
• Store unused labels flat in their original packaging. Leave the sheets of labels inside the original packaging until ready to use. Return any unused sheets of labels to the original packaging and reseal it.
• Do not store label sheets in extreme conditions of temperature or humidity. Storing them in extreme conditions can cause print-quality problems or cause them to jam in the printer.
Printing

- Rotate stock frequently. Long periods of storage in extreme conditions can cause labels to curl and jam in the printer.

Printing Labels from Tray 1

1. Gently pull out the paper tray and slide open the paper guides, then open the output tray to hold the printed labels. For details, see Loading Paper in Tray 1 on page 51.
2. Fan the labels to release sheets that are stuck together.
3. Insert the labels with the label side up and with the top of the sheets at the front of the tray. Do not load more than 25 sheets.
4. Adjust the paper guides to fit the sheets.

5. In the application you are using to print the labels, open the Print dialog box and then click the Properties (or Preferences) button.
6. In the Paper/Output tab of the print driver, do the following:
   a. From the Paper Tray list, select Tray 1.
   b. From the Paper Size list, select the label sheet size.
   c. From the Paper Type list, select Labels.
7. Click OK and then, in the Print dialog box, click OK (or Print) to start printing.

Printing Labels from the Manual Feed Slot

Note: When possible, print labels from Tray 1 to reduce the chance of labels peeling off and causing paper jams in the paper path.

1. Slide the paper guides of the manual feed slot to fit the label sheet and then open the output tray of the printer. For details, see Loading Paper in the Manual Feed Slot on page 53.
2. With the labels face down and the top of the sheet toward the printer, slowly insert it into the manual feed slot until it stops. Ensure that the sheet is entered straight, not crooked. If necessary, reposition the paper guides to fit the sheet.
3. In the application you are using to create the labels, open the Print dialog box and select the Phaser 6500 printer. You can use the PCL or the PostScript driver.

4. Click the Properties button.

5. In the Paper/Output tab, do the following:
   a. From the Paper Size list, select the size of the sheet of labels.
   b. From the Paper Type list, select Labels.
   c. From the Paper Tray list, select Manual Feed Slot.

6. Click OK and then, in the Print dialog box, click OK (or Print) to start printing.

Printing on Glossy Cardstock

This section includes:
- Guidelines for Printing on Glossy Cardstock on page 73
- Printing on Glossy Cardstock from Tray 1 on page 74
- Printing on Glossy Cardstock from the Manual Feed Slot on page 74

Guidelines for Printing on Glossy Cardstock

- You can print on glossy cardstock from Tray 1 or from the manual feed slot.
- For glossy cardstock over 163 g/m², select HW Gloss Card mode. For cardstock lighter than 163 g/m², select LW Gloss Card.
- Do not perform automatic 2-sided printing using glossy cardstock.
- Do not open sealed packages of glossy cardstock until you are ready to load them into the printer.
- Leave glossy cardstock in the original wrapper and store unopened packages in the original shipping carton until ready to use.
- Remove all other paper from the tray before loading glossy cardstock.
- Load only the amount of glossy cardstock you plan to use, and remove the unused portion from the tray when you are finished printing. Put the unused glossy cardstock back in the original wrapper and seal it for later use.
- Rotate stock frequently. Long periods of storage in extreme conditions can cause glossy cardstock to curl and jam the printer.
Printing on Glossy Cardstock from Tray 1

1. Gently pull out the paper tray and slide open the paper guides, then open the output tray to hold the printed sheets. For details, see Loading Paper in Tray 1 on page 51.
2. Fan the sheets to release any that are stuck together.
3. Insert the glossy cardstock into the tray with the print side face up.
   
   Note: Do not load more than 25 sheets. Do not load the paper above the fill line indicated on the tray. Overloading the tray can cause jams.
4. In the application you are using to print from, open the Print dialog box and select the Phaser 6500 printer. You can use the PCL or the PostScript driver.
5. Click the Properties button.
6. In the Paper/Output tab, do the following:
   a. From the Paper Size list, select the paper size.
   b. From the Paper Type list, select LW Gloss Card or HW Gloss Card, as appropriate.
   c. From the Paper Tray list, select Tray 1.
7. Select any other desired settings, such as page orientation, and then click OK.
8. In the Print dialog box, click OK (or Print) to start printing.

Printing on Glossy Cardstock from the Manual Feed Slot

1. Slide the paper guides of the manual feed slot to fit the sheet and then open the output tray of the printer. For details, see Loading Paper in the Manual Feed Slot on page 53.
2. With the top of the sheet toward the printer, slowly insert one sheet into the manual feed slot until it stops. Ensure that the sheet is entered straight, not crooked. If necessary, reposition the paper guides to fit the sheet.
3. In the application you are using to print from, open the **Print** dialog box and select the **Phaser 6500** printer. If you have both the PCL and the PostScript drivers installed, you can use either driver.

4. Click the **Properties** button.

5. In the Paper/Output tab, do the following:
   a. From the Paper Size list, select the size of the glossy cardstock.
   b. From the Paper Type list, select **LW Gloss Card** or **HW Gloss Card, as appropriate**.
   c. From the Paper Tray list, select **Manual Feed Slot**.

6. Click **OK** and then, in the Print dialog box, click **OK** (or **Print**) to start printing.
Printing on Cardstock

This section includes:
- Guidelines for Printing on Cardstock on page 76
- Printing on Cardstock from Tray 1 on page 76
- Printing on Cardstock from the Manual Feed Slot on page 77

Guidelines for Printing on Cardstock

- You can print on lightweight cardstock and heavyweight cardstock from Tray 1 or from the manual feed slot.
- Do not perform automatic 2-sided printing using cardstock.
- Lightweight cardstock acceptable weight for this printer is 100–163 g/m², 37–60 lb.
- Heavyweight cardstock acceptable for this printer is 163–220 g/m², 60–80 lb. cover. Test all thick stock to ensure acceptable performance.
- Do not load cardstock of mixed thicknesses in the tray at the same time; use only one thickness in the tray per print job.
- Do not use cardstocks that are coated or designed for inkjet printers.

Printing on Cardstock from Tray 1

1. Gently pull out the paper tray and slide open the paper guides, then open the output tray to hold the printed sheets. For details, see Loading Paper in Tray 1 on page 51.
2. Fan the sheets to release any that are stuck together.
3. Insert the cardstock into the tray with the print side face up.
   
   **Note:** Do not load a stack of cardstock higher than 27.6 mm (1.08 in.) in the tray.
4. In the application you are printing from, open the Print dialog box and select the Phaser 6500 printer. You can use the PCL or the PostScript driver.
5. Click the Properties button.
6. In the Paper/Output tab, do the following:
   a. From the Paper Size list, select the size of the cardstock.
   b. From the Paper Type list, select either Light Card or Heavy Card as appropriate.
   c. From the Paper Tray list, select Tray 1.
7. Click OK and then, in the Print dialog box, click OK (or Print) to start printing.
Printing on Cardstock from the Manual Feed Slot

1. Slide the paper guides of the manual feed slot to fit the sheet and then open the output tray of the printer. For details, see Loading Paper in the Manual Feed Slot on page 53.
2. With the top of the sheet toward the printer, slowly insert one sheet into the manual feed slot until it stops. Ensure that the sheet is entered straight, not crooked. If necessary, reposition the paper guides to fit the sheet.

3. In the application you are using to print, open the Print dialog box and select the Phaser 6500 printer. You can use the PCL and the PostScript driver.
4. Click the Properties button.
5. In the Paper/Output tab, do the following:
   a. From the Paper Size list, select the size of the cardstock.
   b. From the Paper Type list, select Light Card or Heavy Card as appropriate.
   c. From the Paper Tray list, select Manual Feed Slot.
6. Click OK and then, in the Print dialog box, click OK (or Print) to start printing.
Printing Custom Sizes

This section includes:
- Defining Custom Paper Sizes on page 78
- Printing on Custom-size Paper on page 79

Note: Custom-size paper can be loaded into all trays.

Defining Custom Paper Sizes

This section includes:
- Defining the Custom Page Size in the PostScript Driver on page 78
- Creating a Custom Paper Size for the PostScript Driver on page 79
- Creating a Custom Paper Size for the PCL Driver on page 79

Notes:
- The custom size defined must be within the maximum and minimum size ranges for the printer paper tray you are using. For details, see the custom size paper ranges given for each tray in Supported Paper on page 48.
- You can create custom paper sizes for use with both the PostScript and PCL print drivers, but the method for each is different. For optimum success, follow the instructions carefully.
- If you get an error message when creating a custom size, you could lack permission to save custom paper sizes on your computer system. See your system administrator for help.

Defining the Custom Page Size in the PostScript Driver

Note: This method does not allow you to save the custom size under a unique name in the print driver. You can save only one custom page size at a time in the PostScript Custom Size Settings window of the print driver. Once saved, the dimensions are retained until you change them. You can create a custom paper size for the PostScript driver and save it under a unique name for repeat use. For instructions, see Creating a Custom Paper Size for the PostScript Driver on page 79.

1. Open the settings of the PostScript print driver:
   - In Windows, navigate to your printer directory or list and then right-click the Phaser 6500 PostScript driver and select Properties. In the Properties dialog box, click the Printing Preferences button.
   - In Macintosh, from the Print menu of the application, select the Phaser 6500 printer and then click the Properties button.
2. In the Paper/Output tab of the print driver, from the Paper Size list, select Custom Page Size.
3. In the PostScript Custom Size Settings dialog box, select the units of measurement to use for creating the page size. In the Custom Size Settings section, specify the size for the short edge (width) and the long edge (length) of the paper. Click OK.
4. In the Printing Preferences dialog box, click OK.
   To change the custom size, in the Paper/Output tab, click the Edit button below the Paper Size field. Make the desired changes in the dialog box. Save your changes in all applicable dialog boxes.
Creating a Custom Paper Size for the PostScript Driver

**Note:** This method allows you to create and save a custom paper size under a unique name for use with the PostScript driver. You can create as many custom sizes as your printer trays can handle.

1. In Windows, navigate to your printer directory or list. In the Printers and Faxes folder, click the File menu and select **Server Properties**. The Print Server Properties dialog box appears.
2. In the Forms tab, select the **Create a new form** check box.
3. In the Form name field, type a name for your custom size. Overwrite the name that appears in the field.
4. In the Form description section, select the units of measurement to use for the paper size, then define the width and height and printer margins.
5. Click the **Save Form** button and then click **Close**.
   The custom size is available as an option in the Print dialog box of most applications when you select the Phaser 6500 PostScript driver. The exact location varies with the application.

Creating a Custom Paper Size for the PCL Driver

**Notes:**
- The PCL print driver is available for Windows only.
- Custom paper sizes created in the PCL driver become available in the Paper Size list on the Paper/Output tab of the Print driver. It is also available in the Print dialog box of most applications. The exact location varies with the application.

1. Navigate to your printer directory or list and then right-click the **Phaser 6500** PCL driver and select **Properties**.
2. In the Properties dialog box, click the **Configuration** tab.
3. At the bottom of the Configuration tab, click the **Custom Paper Size** button. The Custom Paper Size dialog box opens.
4. In the Units section, select the units of measurement to use for defining the page size.
5. In the Short Edge field, specify the width of the page. In the Long Edge field, specify the length of the page.
6. To save this custom size, select the **Name Paper Size** check box then type a name for this custom size in the Paper Name field.
7. Click **OK**.
8. In the Properties dialog box of the driver, click **OK**.
   The custom size is available as an option in the Print dialog box of most applications when you select the Phaser 6500 PCL driver. The custom size is also available in the Paper Size field, in the Paper/Output tab of the PCL driver.

Printing on Custom-size Paper

This section includes:
- Printing on Custom-size Paper Using the PostScript Driver on page 80
• **Printing on Custom-size Paper Using the PCL Driver** on page 80

  *Note:* When setting the paper size in the print driver and control panel, be sure to specify the same size as the paper in the tray. Setting the wrong size for printing can cause a printer error. You probably receive more paper size errors when you configure a bigger size when using a narrow-width paper.

**Printing on Custom-size Paper Using the PostScript Driver**

1. Load the custom-size paper in the tray you want to use. For details, see Loading Paper on page 51.
2. In the application you are printing from, open the Print dialog box and select the Phaser 6500 PostScript driver.
3. Do one of the following:
   - **To print using a custom size,** in the Print dialog box, select the custom paper size name from the dialog box size menu or list. Click the **Properties** button and skip to step 4.
   - **To print using the Custom Page Size defined in the PostScript driver properties,** in the Print dialog box, click the **Properties** button. In the Paper/Output tab, select **Custom Page Size** from the Paper Size list. In the PostScript Custom Size Settings dialog box, leave the settings as is or change them to match the paper you are printing on. Click **OK**.
4. In the Paper/Output tab, do the following:
   a. From the Paper Type list, select the paper type.
   b. From the Paper Tray list, select the tray to print from.
5. Select any other desired options and then click **OK**.
6. In the Print dialog box, click **OK** (or **Print**) to start printing.

**Printing on Custom-size Paper Using the PCL Driver**

1. Load the custom-size paper in the tray you want to use. For details, see Loading Paper on page 51.
2. In the application you are printing from, open the Print dialog box and select the Phaser 6500 PCL driver.
3. Click the **Properties** button.
4. In the Paper/Output tab, do the following:
   a. From the Paper Size list, select the name of a custom-size you created.
   b. From the Paper Type list, select the paper type.
   c. From the Paper Tray list, select the tray to print to.
5. Select any other desired options and then click **OK**.
6. In the Print dialog box, click **OK** (or **Print**) to start printing.
Printing on Both Sides of the Paper

This section includes:

- **Automatic 2-Sided Printing Guidelines** on page 81
- **Binding Edge Options** on page 81
- **Automatic 2-Sided Printing** on page 82
- **Manual 2-Sided Printing** on page 82

**Note:** Automatic 2-sided printing is available for the Phaser 6500DN printer configuration. Manual 2-sided printing using Tray 1 is available for both Phaser 6500 configurations. The PCL 6 print driver for Windows is the only one that supports manual 2-sided printing. For details, see **Performing Manual 2-sided Printing from Tray 1** on page 82. However, you can use the manual feed slot to print 2-sided pages one sheet at a time using the PostScript driver. For details, see **Performing Manual 2-sided Printing from the Manual Feed Slot** on page 83.

**Automatic 2-Sided Printing Guidelines**

Before printing a 2-sided document, verify that the paper is a supported size for the tray. For a list of supported sizes, see **Supported Paper** on page 48.

Do not use the following media for automatic 2-sided printing:

- Transparencies
- Envelopes
- Labels
- Any die-cut specialty media, such as business cards
- Cardstock
- Glossy cardstock

**Binding Edge Options**

When you use the print driver to select 2-sided printing, you also select the binding edge. The binding edge determines how the pages turn. The actual outcome depends on the orientation (portrait or landscape) of images on the page, as shown in the following illustrations.
Automatic 2-Sided Printing

You can perform automatic 2-sided printing from Tray 1 and, if installed, the 250-sheet feeder (Tray 2).

To perform automatic 2-sided printing:
1. Insert the paper into the desired tray. For more information, see Loading Paper on page 51.
2. In the print driver, select 2-sided printing:
   - Windows users: In the Paper/Output tab, from the 2-Sided Print drop-down list, select either Flip on long edge or Flip on short edge.
   - Macintosh users: In the Print dialog box, from the Presets menu, select Layout. Then select either Long-edged printing or Short-edged printing.
   For details, see Binding Edge Options on page 81.
3. Select any other desired printing options and then click OK and then click OK again (or Print) to start printing.
   Note: For optional printer features to be available in the print driver dialogs, the optional features must be installed and enabled. If you have not enabled your installed optional features, see Enabling Optional Features on page 41.

See also:
   Automatic 2-Sided Printing Guidelines on page 81

Manual 2-Sided Printing

This section includes:
- Performing Manual 2-sided Printing from Tray 1 on page 82
- Performing Manual 2-sided Printing from the Manual Feed Slot on page 83

If you do not have the optional duplex unit installed, you can still print on both sides of some paper using the following instructions. You can also use this procedure for printing on paper incompatible with the duplex unit.

CAUTION: Use only paper specified for use with this printer. Damage caused by unsupported paper is not covered under the Xerox® Warranty, Service Agreement, or Total Satisfaction Guarantee. The Total Satisfaction Guarantee is available in the United States and Canada. Coverage can vary outside these areas. Please contact your local representative for details.

Performing Manual 2-sided Printing from Tray 1

Notes:
- This method of manual 2-sided printing is only available using the PCL print driver.
- Do not perform manual 2-sided printing on cardstock or glossy cardstock using this method.
1. Load Tray 1 with the desired paper acceptable for use in Tray 1. For details, see Supported Paper on page 48.
2. In the application you are printing from, open the Print dialog box and select the Phaser 6500 PCL driver.

3. Click the Properties button.

4. Click the Advanced tab.

5. In the Other Settings section, in the Items list, select Electronic Sort. In the Electronic Sort field below the Items list, select Off.

6. Click the Paper/Output tab and do the following:
   a. From the Paper Tray list, select Tray 1.
   b. From the 2-Sided Print list, select either Flip on long edge (Manual) or Flip on short edge (Manual).
   c. From the Paper Type field, select the paper type.
   d. Select any other desired settings and then click OK.

7. In the Print dialog box, select the pages to print and then click OK (or Print) to start printing.
   Note: You do not need to select to print odd or even pages only. Either select to print all pages or a page range. The driver prints the even pages first and then the printer waits for you to insert the printed pages back into Tray 1.

8. The Setting Method for Paper Tray 1 Duplex window appears on your computer screen.
   Note: Keep this window open until you are finished with the entire print job, because you cannot access it easily once you close it. This window explains how to reload the printed pages into the paper tray. If you close the window, do the following: without turning the pages over or around, lift them as they are and place them into the paper tray. If you have performed the procedure correctly, the blank sides of the page are facing up. Close the tray.

9. On the printer control panel, click the OK button to resume printing.

Performing Manual 2-sided Printing from the Manual Feed Slot

1. After printing on one side of a sheet of paper, adjust the paper guides in the manual feed slot to fit the paper.

2. Slowly and evenly insert the paper (one sheet only) into the manual feed slot with print side face down. The printer grabs and holds the paper.

3. If the paper looks skewed after the printer pulls it in, gently remove the paper and insert it again.

4. Open the print file if it is not already open and then select Print from the File menu.

5. In the Print dialog box, select the desired print driver and then click the Properties button.

6. In the Paper/Output tab, select the following:
   a. From the Paper Size list, select the paper size.
   b. From the Paper Type list, select the paper type.
   c. From the Paper Tray list, select Manual Feed Slot.

7. Click OK.

8. In the Print dialog box, select the page you want to print on the sheet and then click Print (or OK) to start printing.
Printing Using Secure Print

This section includes:
- Setting Up a Secure Print Job on page 84
- Printing a Secure Print Job on page 85
- Storing a Print Job in Memory on page 86
- Printing a Stored Job on page 86

Notes:
- Secure Print requires the Productivity Kit to be installed in the printer. For information on your printer configuration and available optional features, see Configurations and Options on page 21.
- The RAM Disk feature of the printer must also be enabled for you to use Secure Print. For information on enabling this option, see Enabling Optional Features on page 41.

Secure Print enables you to store a document in the printer, then print it from the printer control panel. When you send the Secure Print document to the printer, you assign a password for printing the document. To retrieve the print job, enter the same password at the control panel of the printer. You can use this feature to send confidential documents to the printer and print them when you are at the printer.

You can also store documents in the printer without assigning a password. By storing frequently used documents in the printer, you can print them on demand from the printer without sending the print job from the computer repeatedly.

Setting Up a Secure Print Job

You set up Secure Print print jobs in the print driver at your computer. Both the PCL and PostScript drivers can be used for Secure Print. After setup, you can print the job from the control panel of the printer.

1. From the application you are using to print, open the Print dialog box. For example, from the File menu, select Print.
2. Select your Phaser 6500 printer (PostScript or PCL print driver) and then click the Properties button.
3. In the Paper/Output tab of the print driver Properties dialog box, do the following:
   a. From the Job Type list, select Secure Print.
   b. If you are using the PostScript driver, click the Setup button. If you are using the PCL driver, click the Setting button.
   c. In the Secure Print dialog box, type your name (8-character limit) in the Username field. Enter a numeric password in the Password field.
   d. At the Retrieve Document Name field, do one of the following:
      - To use a specific document name to access the document from the printer control panel, select Enter Document Name. In the Document Name field, type the name of the document as you want it to appear on the printer control panel (12-character limit).
• To display a timestamp instead of a document name on the control panel, select Use Existing Name if you are using the PostScript driver. If you are using the PCL driver, select Auto Retrieve.

e. Click OK.

4. Select any other desired printing options including paper tray, paper type and paper size, and then click OK.

5. In the Print dialog box, click OK (or Print).

6. When you are ready to print, follow the instructions in Printing a Secure Print Job on page 85.

Note: Any print jobs stored in the RAM are erased when the printer is turned off or loses power.

Printing a Secure Print Job

1. To print a Secure Print at the printer control panel, press the Back Arrow button to access the Walk-Up printing feature.

2. At Secure Print, press the OK button.

3. At your user name, the name you assigned to the document when you set up the Secure Print, press OK.

   • To enter the password, use the arrow buttons to select the password numbers one at a time:
     press the Up Arrow button to increase the number, use the Down Arrow button to decrease the number.

   • After entering each number, press the Forward Arrow button. The number you just entered displays as an asterisk to keep it private.

   • Enter the next number in the password using the same process as before.

   • After entering all of the numbers in the password, press OK.

4. Do one of the following:

   • If you selected to retrieve the document using a specific name, then press the Down Arrow button to scroll to the name and press OK.

   • If you selected to retrieve the document using a timestamp, at Select Document a time stamp appears on the control panel menu. Press OK.

5. Select from the following:

   • To delete the document from memory after printing, at Delete after Print press OK.

   • To print the document and keep it in the memory of the printer after printing, use the Down Arrow button to scroll to Print and Save and then press OK.

Note: Any print jobs stored in the RAM are erased when the printer is switched off or loses power. To delete the document without printing it, press the Down Arrow button to scroll to Delete and then press OK.

6. Set the number of copies to print using Up Arrow or Down Arrow buttons and then press OK to start printing.

See also:

   Setting Up a Secure Print Job on page 84
Storing a Print Job in Memory

To store documents in the printer RAM, you must have the Productivity Kit installed in your printer and RAM Disk enabled. This feature allows you to store a frequently used print job in the RAM of the printer for printing at any time. The print job stays in the memory until it is deleted or the printer is turned off.

To create a stored print job:
1. From the application you are using to print, open the Print dialog box.
2. Select your Phaser 6500 print driver, either PCL or PostScript, and then click the Properties button.
3. In the Paper/Output tab of the print driver Properties dialog box, do the following:
   a. From the Job Type list, select Secure Print. The Setup (or Setting) button becomes available.
   b. Click the Setup (or Setting) button.
   c. In the Username field of the Secure Print dialog box, type the user name you want to associate with this print job (8-character limit).
   d. You can enter a numeric password in the Password field or, to make this job available to anyone, leave the password field empty.
   e. At the Retrieve Document Name field, select Enter Document Name. In the Document Name field, type the name of the document as you want it to appear on the printer control panel (12-character limit).
   f. Click OK.
4. Select any other desired printing options including paper tray, paper type and paper size, and then click OK.
5. In the Print dialog box, click OK (or Print).

See also: Enabling Optional Features on page 41

Printing a Stored Job

1. At the printer control panel, press the Back Arrow button to access the Walk-Up printing menu.
2. At Secure Print, press the OK button.
3. Use the Up Arrow and Down Arrow buttons to scroll to the username associated with the stored document you want to print. Press OK.
4. If a password was set for the stored job, follow step 4 in Printing a Secure Print Job on page 85.
5. Press the Down Arrow button to scroll to the document name, the name entered in the Document Name field of the Secure Print dialog box, and then press OK.
6. Press the Down Arrow button to scroll to Print and Save and press OK.
   
   Note: To delete a stored print job after printing, select Delete after Print instead of Print and Save. All print jobs are deleted when the printer is turned off.

7. Set the number of copies to print using the Up Arrow or Down Arrow buttons and then press OK to start printing.
Printing Using Proof Print

This section contains:

- Setting Up a Proof Print Job on page 87
- Printing a Proof Print Job on page 88

Notes:

- Proof Print requires that you have the Productivity Kit installed in the printer. For information on your printer configuration and available optional features, see Configurations and Options on page 21.
- The RAM Disk feature of the printer must also be enabled for you to use Proof Print. For information on enabling this option, see Enabling Optional Features on page 41.

The Proof Print feature enables you to store a multiple-copy print job in the printer, then verify one set before printing the remainder. If you are satisfied with the first set, you can print the remaining copies from the control panel.

Setting Up a Proof Print Job

You set up Proof Print print jobs in the print driver at your computer. You can use the PCL or the PostScript drivers for Proof Print. After setup, one copy of the job prints for you to review. Then you can print the rest of the copies or delete them from the printer control panel.

1. From the application you are using to print, open the Print dialog box.

2. Select your Phaser 6500 printer (PostScript or PCL print driver) and then click the Properties button.

3. In the Paper/Output tab of the print driver Properties dialog box, do the following:
   a. From the Job Type list, select Proof Print.
   b. If you are using the PostScript driver, click the Setup button. If you are using the PCL driver, click the Setting button.
   c. In the Proof Print dialog box, type your name (8-character limit) in the Username field.
   d. At the Retrieve Document Name field, do one of the following:
      • To use a specific document name to access the document from the printer control panel at the time of printing, select Enter Document Name. In the Document Name field, type the name of the document as you want it to appear on the printer control panel (12-character limit).
      • To have the control panel display a timestamp instead of a document name, select Use Existing Name if you are using the PostScript driver. If you are using the PCL driver, select Auto Retrieve.
   e. Click OK.

4. Select any other desired printing options including paper tray, paper type and paper size, and then click OK.

   Note: Do not select the number of copies in the print driver; you do that at the control panel later when you print.

5. In the Print dialog box, click OK (or Print).
6. One set of the job prints. Review this set. If the set is satisfactory, you can print the remaining sets from the control panel. For details, see Printing a Proof Print Job on page 88.

Printing a Proof Print Job

1. After reviewing the first set that printed when you sent the document, you can print the remaining sets from the control panel. At the printer control panel, press the Back Arrow button to access the Walk-Up printing feature.
2. Press the Down Arrow button to go to Proof Print and then press the OK button.
3. At your user name, or the name you supplied to use for retrieving the document when you set up the Proof Print. Press OK.
4. Do one of the following:
   • If you selected to retrieve the document using a specific name, then at the name of the document, press OK.
   • If you selected to retrieve the document using a timestamp, Select Document and a time stamp appear on the control panel menu. Press OK.
5. Select from the following:
   • To print the document and then delete it from memory after printing, at Delete after Print, press OK.
   • To print the document and keep it in the printer memory after printing, press the Down Arrow button to scroll to Print and Save and then press OK.

   Note: Any print jobs stored in the RAM are erased when the printer is turned off or loses power.
6. Press the Up Arrow or Down Arrow buttons to set the number of sets to print and then press OK.

See also:
Setting Up a Proof Print Job on page 87
Control Panel Menus

This chapter includes:

- Navigating the Control Panel Menus on page 90
- Information Pages Menu on page 91
- Billing Meters on page 92
- Admin Menu on page 93
- Tray Settings Menu on page 102
Navigating the Control Panel Menus

The following table describes the navigation and function buttons on the control panel used to select menu options and operate certain printer features.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Menu icon" /></td>
<td><strong>Menu</strong></td>
<td>Controls access to the menus or the print screen.</td>
</tr>
<tr>
<td><img src="image" alt="OK icon" /></td>
<td><strong>OK</strong></td>
<td>Select or execute the option or function displayed on the screen.</td>
</tr>
<tr>
<td><img src="image" alt="Power Saver icon" /></td>
<td><strong>Power Saver</strong></td>
<td>Lighted button. Controls entry and exit from Energy Saver mode. Light on indicates the printer is in Energy Saver mode. Light off indicates the printer is awake and ready to print.</td>
</tr>
<tr>
<td><img src="image" alt="Stop/Cancel icon" /></td>
<td><strong>Stop/Cancel</strong></td>
<td>Stops the current printer operation or cancels the current print or copy job.</td>
</tr>
<tr>
<td><img src="image" alt="Up/Down Arrows" /></td>
<td><strong>Up/Down Arrows</strong></td>
<td>Moves the menu options up or down in the display screen.</td>
</tr>
<tr>
<td><img src="image" alt="Back/Forward Arrows" /></td>
<td><strong>Back/Forward Arrows</strong></td>
<td>Moves the selection point back and forward through the displayed menu options. The <strong>Back Arrow</strong> button displays the Walk-Up Features menu if you press it before pressing any other buttons.</td>
</tr>
<tr>
<td><img src="image" alt="Back/Return icon" /></td>
<td><strong>Back/Return</strong></td>
<td>Navigates up one menu level.</td>
</tr>
</tbody>
</table>
Information Pages Menu

Your printer comes with a set of information pages to help you track the performance of the printer and diagnose problems. Access the information pages from the printer control panel. You can print the Menu Map to see where these information pages are located in the control panel menu structure.

<table>
<thead>
<tr>
<th>Information Page</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu Map</td>
<td>Prints a list of all main and second-level menu headings that you can use to help navigate the control panel menus.</td>
</tr>
<tr>
<td>Demo Page</td>
<td>Prints an image using all printer colors to show the current ability to print color from the printer.</td>
</tr>
<tr>
<td>Configuration</td>
<td>Prints information such as default printer settings, installed options, network settings, and font settings.</td>
</tr>
<tr>
<td>PCL Fonts List</td>
<td>Prints information about the installed PCL fonts on the printer and prints samples of each.</td>
</tr>
<tr>
<td>PCL Macro List</td>
<td>Prints a list of configured PCL macros.</td>
</tr>
<tr>
<td>PS Fonts List</td>
<td>Prints information about the installed PostScript fonts on the printer and prints samples of each.</td>
</tr>
<tr>
<td>Job History</td>
<td>Prints recent print-job history on up to the last 22 jobs.</td>
</tr>
<tr>
<td>Error History</td>
<td>Prints information on up to the last 42 printer errors that occurred. The Error History Report provides a list of error messages and Chain Link codes relating to paper jam errors in the system. The printer retains up to 42 jam errors and 42 system fail errors at a time.</td>
</tr>
<tr>
<td>Print Meter</td>
<td>Prints the print meter. The print meter contains job accounting information, broken down by user name, showing how many pages have been printed. It also indicates how many pages printed by size, in color, and in black and white. The print meter can be reset.</td>
</tr>
<tr>
<td>Stored Document</td>
<td>Prints a list of documents stored in the RAM of the printer when the Secure Print and Proof Print features are used.</td>
</tr>
</tbody>
</table>

See also:  
Information Pages on page 24
Billing Meters

The Billing Meters menu shows the number of processed print jobs. The meters are divided according to the color modes. You cannot print the billing meters and you cannot reset them; they track the total number of pages printed for the life of the printer.

The print meter, in contrast, can be reset, and you can print the information as the Print Volume report. For details, see Checking Page Counts on page 115.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Impression</td>
<td>Displays the total number of pages printed.</td>
</tr>
<tr>
<td>Color Impression</td>
<td>Displays the total number of pages printed in color.</td>
</tr>
<tr>
<td>Black Impression</td>
<td>Displays the total number of pages printed in black and white. Grayscale images printed with the composite black setting count as color pages, because color consumables are used. Composite black is the default setting on most printers.</td>
</tr>
</tbody>
</table>

See also:
- Checking Print Job Status on page 111
- Checking Page Counts on page 115
Admin Menu

The Admin Menu contains the following sub menus:

- Network Setup Menu on page 93
- USB Setup Menu on page 94
- System Setup Menu on page 95
- Maintenance Mode Menu on page 97
- PCL Setup Menu on page 98
- PostScript Setup Menu on page 100
- Control Panel Menu on page 101

Use the Admin Menu to access the configuration settings of the printer.

Network Setup Menu

Use this menu to configure printer settings for jobs sent to the printer through a network port.

Notes:
- The settings in the Network Setup menu cannot be selected if you access this menu during printing.
- Restart the printer to activate menu setting changes. After changing settings, turn off the printer, then turn it on again.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| Ethernet| Specifies the Ethernet communication speed and modes.  
  - Auto (default): Automatically changes between 10M Half Duplex, 10M Full Duplex, 100M Half Duplex, 100M Full Duplex, and 1000 Full Duplex.  
  - 10Base Half  
  - 10Base Full  
  - 100Base Half  
  - 100Base Full  
  - 1000Base Full |
| TCP/IP  | Specifies the settings to use for TCP/IP:  
  - IP Mode: IPv4 Mode, IPv6 Mode, or Dual Stack  
  - IPv4: Get IP Address, IP Address, Network Mask, Gateway Address  
  - IPsec: IP security protocol; available when enabled |
### USB Setup Menu

Use this menu to configure the USB port.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port Status</td>
<td>Use to enable or disable the USB port status. This port must be enabled for you to print to a USB-connected printer.</td>
</tr>
<tr>
<td></td>
<td>- Enable</td>
</tr>
<tr>
<td></td>
<td>- Disable</td>
</tr>
<tr>
<td>Adobe Protocol</td>
<td>Specifies the PostScript communication protocol to use:</td>
</tr>
<tr>
<td></td>
<td>- Standard</td>
</tr>
<tr>
<td></td>
<td>- BCP</td>
</tr>
<tr>
<td></td>
<td>- TBCP</td>
</tr>
<tr>
<td></td>
<td>- Binary</td>
</tr>
<tr>
<td></td>
<td>- Auto</td>
</tr>
</tbody>
</table>
System Setup Menu

Use this menu to configure the general operation settings of the printer. For example, time to energy saver mode, alarm settings, and so on.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power Saver Time</td>
<td>Specifies the length of time, 5–60 minutes, that the printer is idle before going into Energy Saver mode. For details on setting the Power Saver Time, see Setting the Power Saver Time on page 23.</td>
</tr>
</tbody>
</table>
| Audio Tones      | Specifies whether an alarm sounds when one of the following printer errors or actions occurs. The alarms are set to Off by default. The volume cannot be adjusted.  
• Control Panel  
• Invalid Key  
• Machine Ready  
• Job Complete  
• Fault Tone  
• Alert Tone  
• Out of Paper  
• Low Toner Alert  
• Base Tone |
<p>| Fault Time-Out   | Specifies the amount of time before the printer automatically deletes a print job when there has been a job error. Set the default timeout, up to 60 seconds, in one-second increments. |
| Time-Out         | Automatically cancels a print job when it goes beyond a specified time. Set the duration allowed for the print time. When the time expires, the print job is canceled. Duration can be set for up to 30 minutes in one-minute increments. |
| Language         | Specifies the language used in the control panel menus and in printed Information Pages. |</p>
<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| Auto Log Print     | Specifies whether to print a Job History Report after 22 print jobs.  
  • Off (default): Prevents the Job History Report from printing automatically even if the number of print jobs exceeds 22.  
  • On: Automatically prints a report when the number of print jobs reaches 22.  
  **Note:**  
  • You cannot set Auto Log Prints during printing.  
  • After changing this setting, turn off the printer and then turn it on again to activate the change. |
| Print ID           | Prints the user ID in the specified place on the printed page.  
  • Off (default): The user ID is not printed.  
  • Top Left: Prints the user ID on the top left of the page.  
  • Top Right: Prints the user ID on the top right of the page.  
  • Bottom Left: Prints the user ID on the bottom left of the page.  
  • Bottom Right: Prints the user ID on the bottom right of the page. |
| Print Text         | Specifies whether the printer outputs unsupported PDL data as text when the printer receives it. Text data is printed on A4 or Letter-size paper.                                                               |
| RAM Disk           | This feature is available when the memory in the printer is expanded from 256 MB to at least 512 MB RAM. Allocates memory to the RAM Disk file system for the Secure Print, Collating Jobs, and Proof Print, Form Overlay, and Font Download features.  
  • Enable  
  • Disable (default) |
| Size Mismatch      | Specifies how the printer reacts when it detects differences between the sizes of paper specified at the control panel and that loaded in the tray. If the paper in the specified tray runs out, the printer selects the substitute tray based on the Size Mismatch settings.  
  When a Paper Type other than None is selected in the print driver, it overwrites the Size Mismatch setting on the control panel.  
  • Off (default): The printer prompts you to select a tray for printing.  
  • Larger Size: The printer uses a tray that has paper larger than the size specified for the print job but prints the page at 100% magnification.  
  • Nearest Size: The printer uses a tray that has paper nearest to the size specified in the print job. The page prints at 100% magnification. |
| mm/inch            | Specifies the units of measurement to use for the custom paper sizes:  
  • Millimeters (mm)  
  • Inches |
| Default Size       | Specifies the default paper size as either A4 or Letter.                                                                                                                                                     |
| Startup Page       | Automatically prints the Startup Page when the printer is turned on.  
  • On  
  • Off |
## Maintenance Mode Menu

Use this menu to configure color registration and to reset defaults.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>F/W Version</td>
<td>Displays the current firmware version installed in the printer.</td>
</tr>
<tr>
<td>Auto Regi Adj.</td>
<td>Auto Registration Adjust. When On (the default), the color registration is adjusted automatically.</td>
</tr>
<tr>
<td>Adjust Color Regi.</td>
<td>Adjust Color Registration. Used to correct the color registration between colors. For details, see Color Registration on page 136.</td>
</tr>
<tr>
<td></td>
<td>• Auto Adjust: Use to force an automatic color registration correction.</td>
</tr>
<tr>
<td></td>
<td>• Color Regi Chart: Prints the color registration chart used to check for correct color registration.</td>
</tr>
<tr>
<td></td>
<td>• Enter Number: Use to select and correct color registration numbers.</td>
</tr>
<tr>
<td></td>
<td>• Fast Scan (1): For setting horizontal color registration, or Slow Scan (2) for setting vertical color registration.</td>
</tr>
<tr>
<td>Clear Developer</td>
<td>Resolves print-quality defects associated with charge problems after high-coverage print jobs.</td>
</tr>
<tr>
<td>Toner Refresh</td>
<td>Resolves print-quality defects associated with charge problems after low-coverage jobs.</td>
</tr>
<tr>
<td>IU Refresh (Imaging Unit Refresh)</td>
<td>Helps improve imaging unit operation by performing a density and color curve calibration.</td>
</tr>
<tr>
<td>Init Print Meter</td>
<td>Initialize Print Meter. Resets the Print Meter.</td>
</tr>
<tr>
<td>Initialize NVM</td>
<td>Resets the settings in the nonvolatile memory (NVM), except for the network settings, to their defaults. NVM is memory that stores the printer settings even after the power is turned off. After selecting this option and restarting the printer, all the menu settings are reset to their default values.</td>
</tr>
<tr>
<td></td>
<td>Note:</td>
</tr>
<tr>
<td></td>
<td>• You cannot execute the Initialize NVM setting during printing.</td>
</tr>
<tr>
<td></td>
<td>• After changing this setting, turn off the printer and then turn it on again to activate the change.</td>
</tr>
</tbody>
</table>
PCL Setup Menu

Use this menu to configure settings for PCL. The PCL driver is used for applications requiring PCL. For PCL print driver options, see Printing Options for Windows PCL Driver on page 63.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper Tray</td>
<td>Specifies the paper tray to use when the Paper Tray setting in the PCL print driver is set to Auto Select.</td>
</tr>
<tr>
<td></td>
<td>• Auto (default)</td>
</tr>
<tr>
<td></td>
<td>• Tray 1</td>
</tr>
<tr>
<td></td>
<td>• Tray 2 (optional; if installed)</td>
</tr>
<tr>
<td></td>
<td>• Manual Feed Slot</td>
</tr>
<tr>
<td>Paper Size</td>
<td>Specifies the default paper size to print.</td>
</tr>
<tr>
<td>Orientation</td>
<td>Specifies the default paper orientation:</td>
</tr>
<tr>
<td></td>
<td>• Portrait (default)</td>
</tr>
<tr>
<td></td>
<td>• Landscape</td>
</tr>
<tr>
<td>2-Sided</td>
<td>Specifies 2-sided printing settings:</td>
</tr>
<tr>
<td></td>
<td>• 2-Sided Print: Specifies whether to perform 2-sided printing. The default is Off. The default setting is ON when the duplex unit is installed.</td>
</tr>
<tr>
<td></td>
<td>• Binding Edge: Specifies the binding direction from Flip Long Edge (default) or Flip Short Edge.</td>
</tr>
<tr>
<td>Font</td>
<td>Specifies the font to use. The default font is Courier.</td>
</tr>
<tr>
<td>Symbol Set</td>
<td>Specifies the font to use for symbols. The default is Roman-8.</td>
</tr>
<tr>
<td>Font Size</td>
<td>Specifies the font size. The default size is 12.00. You can specify a value from 4.00 through 50.00 in increments of 0.25. Available only for typographic fonts.</td>
</tr>
<tr>
<td>Font Pitch</td>
<td>Specifies the character spacing. You can specify a value from 6.00 through 24.00 in increments of 0.01. The default is 10.00.</td>
</tr>
<tr>
<td>Form Line</td>
<td>Specifies the form line (the number of lines per form). You can specify a value from 5 through 128 in increments of 1. The default is 60.</td>
</tr>
<tr>
<td>Quantity</td>
<td>Specifies the number of copies to print. You can specify a value from 1 through 999. The default is 1.</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Image Enhance      | Selects whether to perform image enhancement. The image enhancement feature makes the boundary line between black and white smoother to decrease jags and enhance the visual appearance.  
|                    | • On (default)  
|                    | • Off                                                        |
| Hex Dump           | Specifies whether to print the data sent from a computer in the ASCII code corresponding to the hexadecimal notation format. The Hex Dump allows checking of data contents.  
|                    | • Enable  
|                    | • Disable (default)                                        |
| Draft Mode         | Specifies whether to print in draft mode.  
|                    | • Enable  
|                    | • Disable (default)                                        |
| Line Termination   | Allows the administrator to configure what line endings are used when printing PCL or text files.  
|                    | • Off: Line termination commands are not added.  
|                    | • Add-LF: The Line Feed command is added.  
|                    | • Add-CR: The Carriage Return command is added.  
|                    | • CR-XX: The Line Feed and Carriage Return commands are both added.                                                                            |
| Default Color      | Specifies the default color mode:  
|                    | • Black (default)  
|                    | • Color
PostScript Setup Menu

Use this menu to configure settings for the PostScript driver. The PostScript driver of the printer is used for applications requiring PostScript. For PostScript driver options, see Printing Options for Windows PostScript Driver on page 62 and Printing Options for Macintosh OS X Version 10.5 or Later on page 65.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PS Error Report</td>
<td>Turns error reporting on or off. The default is On.</td>
</tr>
<tr>
<td>PS Job Time-Out</td>
<td>Turns off the timeout, or selects the length of time before timing out. The default is Off. The timeout allows the printer to stop working on the canceled job and switch to another waiting print job when:</td>
</tr>
<tr>
<td></td>
<td>• A print job at the source computer by canceling before the job is completed.</td>
</tr>
<tr>
<td></td>
<td>• The network connection is lost before the print job is completed.</td>
</tr>
<tr>
<td>Paper Select Mode</td>
<td>Specifies how the printer handles tray switching when the selected tray runs out of paper while printing. Tray settings in the PostScript print driver can override this setting.</td>
</tr>
<tr>
<td>Default Color</td>
<td>Specifies the default color mode:</td>
</tr>
<tr>
<td></td>
<td>• Color (default)</td>
</tr>
<tr>
<td></td>
<td>• Black</td>
</tr>
</tbody>
</table>
## Control Panel Menu

Use this menu to control access to the printer settings by means of a password.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Panel Lock</td>
<td>Specifies whether to limit the menu operations with a password:</td>
</tr>
<tr>
<td></td>
<td>• Enable: Requires the operator to enter the password. If On is set, then</td>
</tr>
<tr>
<td></td>
<td>enter the password to use the Admin Menu.</td>
</tr>
<tr>
<td></td>
<td>• Disable (default): All menus are accessible.</td>
</tr>
<tr>
<td>Change Password</td>
<td>Enabled when Panel Lock is enabled. Use to change the Panel Lock password</td>
</tr>
<tr>
<td></td>
<td>for access to the Admin Menu on the control panel.</td>
</tr>
</tbody>
</table>
Tray Settings Menu

Use this menu to configure settings for each of the paper trays in the printer.

When the size or type of paper loaded is different from the setting, print quality can be reduced or paper jams can occur. It can also cause paper to jam in the printer. Specify the correct paper type and size.

When the optional 250-sheet feeder is installed, and the Paper Tray setting of the driver is set to Auto Select:

- For the PCL driver, the printer uses the tray selected in the PCL Setup menu of the control panel. For details, see Printing Options for Windows PCL Driver on page 63.
- For the PostScript driver, the printer uses the tray selected in the PostScript Setup menu at the control panel. For details, see Printing Options for Windows PostScript Driver on page 62.

When the paper size and type settings for the trays are the same, printing is uninterrupted when the paper runs out in the specified tray, printing is uninterrupted. Printing continues by changing to the other tray when it is installed.

### Tray 1 Settings

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper Type</td>
<td>Specifies the type of paper loaded in the tray.</td>
</tr>
<tr>
<td></td>
<td>• Plain</td>
</tr>
<tr>
<td></td>
<td>• Bond</td>
</tr>
<tr>
<td></td>
<td>• Light Card</td>
</tr>
<tr>
<td></td>
<td>• Heavy Card</td>
</tr>
<tr>
<td></td>
<td>• LW Gloss Card</td>
</tr>
<tr>
<td></td>
<td>• HW Gloss Card</td>
</tr>
<tr>
<td></td>
<td>• Envelope</td>
</tr>
<tr>
<td></td>
<td>• Letterhead</td>
</tr>
<tr>
<td></td>
<td>• Hole Punched</td>
</tr>
<tr>
<td></td>
<td>• Recycled</td>
</tr>
<tr>
<td></td>
<td>• Colored</td>
</tr>
<tr>
<td></td>
<td>• Special</td>
</tr>
</tbody>
</table>
250-Sheet Feeder (Tray 2) Settings

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper Type</td>
<td>Specifies the type of paper loaded in the tray.</td>
</tr>
<tr>
<td></td>
<td>• Plain</td>
</tr>
<tr>
<td></td>
<td>• Letterhead</td>
</tr>
<tr>
<td></td>
<td>• Hole Punched</td>
</tr>
<tr>
<td></td>
<td>• Colored Paper</td>
</tr>
</tbody>
</table>

Display Popup Displays a message that prompts you to set the paper size and type every time you load paper in the tray.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>A message prompts the user to set the paper size and type.</td>
</tr>
<tr>
<td>On</td>
<td>A message prompts the user to set the paper size and type.</td>
</tr>
<tr>
<td></td>
<td>Off (default): No message is displayed.</td>
</tr>
</tbody>
</table>
### Paper Size

Specifies the paper size and orientation of the paper in the tray.
- Letter
- US Folio
- Legal
- Executive
- New Custom Size
- A4
- A5
- B5

### Display Popup

Displays a message that prompts you to set the paper size and type every time you load paper in the tray.
- On: A message prompts the user to set the paper size and type.
- Off (default): No message is displayed.
Maintenance

This chapter includes:
- Cleaning the Printer on page 106
- Ordering Supplies on page 108
- Managing the Printer on page 110
- Checking Page Counts on page 115
- Moving the Printer on page 117
Cleaning the Printer

This section includes:

- **General Precautions** on page 106
- **Cleaning the Exterior** on page 107
- **Cleaning the Interior** on page 107

General Precautions

**WARNING:** When cleaning your printer do not use organic or strong chemical solvents or aerosol cleaners. Do not pour fluids directly into any area. Use supplies and cleaning materials only as directed in this documentation. Keep all cleaning materials out of the reach of children.

**WARNING:** Internal parts of the printer can be hot, especially the fuser. Use caution when doors and covers are open.

**WARNING:** Do not use pressurized air-spray cleaning aids on or in the printer. Some pressurized air-spray containers contain explosive mixtures and are not suitable for use in electrical applications. Use of such cleaners can result in a risk of explosion and fire.

**WARNING:** Do not remove the covers or guards that are fastened with screws. You cannot maintain or service any parts that are behind these covers and guards. Do not attempt any maintenance procedure that is not described in the documentation supplied with your printer.

To avoid damaging the printer, follow these guidelines:

- Do not place anything on top of the printer.
- Do not leave the covers and doors open for any length of time, especially in well-lit places. Light exposure can damage the imaging units.
- Do not open covers and doors during printing.
- Do not tilt the printer while in use.
- Do not touch the electrical contacts, gears, or laser devices. Doing so could damage the printer and cause the print quality to deteriorate.
- Make sure any parts removed during cleaning are reinstalled before you plug in the printer.
Cleaning the Exterior

Clean the exterior of the printer about once a month. Wipe the parts with a damp, soft cloth. Then wipe with another dry, soft cloth. For stubborn stains, apply a small amount of neutral detergent to the cloth and gently wipe the stain off.

**CAUTION:** Do not spray the detergent directly on the printer. The liquid detergent could enter the printer through a gap and cause problems. Never use cleaning agents other than water or neutral detergent.

Cleaning the Interior

After clearing paper jams or replacing one of the toner cartridges, inspect the inside of the printer before closing the printer covers.

Remove any remaining pieces of paper. For more information, see Clearing Paper Jams on page 142.

Remove any dust or stains with a dry, clean cloth.

**WARNING:** Never touch a labeled area found on or near the heat roller in the fuser. You can get burned. If a sheet of paper is wrapped around the heat roller, do not try to remove it immediately to avoid injuries or burns. Switch off the printer immediately and wait 40 minutes for the fuser to cool.

1. Fuser
2. Transfer belt unit
Ordering Supplies

This section includes:
- Consumables on page 108
- Routine Maintenance Items on page 108
- When to Order Supplies on page 109
- Recycling Supplies on page 109

Consumables

Consumables are printer supplies that get depleted during the operation of the printer. Consumable supplies for this printer are the genuine Xerox® Toner Cartridges (Cyan, Magenta, Yellow, and Black).

Notes:
- Each toner cartridge includes installation instructions.
- Install only new cartridges in your printer. If a used toner cartridge is installed, then the toner remaining amount displayed could be inaccurate.
- To enhance print quality, the toner cartridges have been designed to cease functioning at a predetermined point.

**CAUTION:** Use of toner other than genuine Xerox® Toner can affect print quality and printer reliability. Xerox® Toner is the only toner designed and manufactured under strict quality controls by Xerox® for specific use with this printer.

Routine Maintenance Items

Routine maintenance items are printer parts that may require replacement. Replacements can be parts or kits. Routine maintenance items can be parts or kits and are typically customer replaceable. Routine maintenance items for this printer include the following:
- Fuser
- Feed Roller Kit
- Imaging Unit

*Note:* Although the transfer belt unit is not considered a routine maintenance item, if it becomes damaged, you can order another one. You can also order a duplex unit.

To order routine maintenance items, contact your local Xerox® authorized service provider, contact your local Xerox® customer service representative, or go to the Xerox® Supplies website at www.xerox.com/office/6500supplies. You can also call the Xerox® Direct Store at 1-866-495-6286.
When to Order Supplies

The printer control panel displays a warning when a supply nears its replacement time. Verify that you have replacements on hand. It is important to order these supplies when the messages first appear to avoid interruptions to your printing. The control panel displays an error message when the supply must be replaced.

**CAUTION:** Use of non-Xerox® supplies is not recommended. The Xerox® Warranty, Service Agreements, and Total Satisfaction Guarantee do not cover damage, malfunction, or degradation of performance caused by use of non-Xerox® supplies. They also do not cover damage or degradation of performance caused by the use of Xerox® supplies not specified for this printer. The Total Satisfaction Guarantee is available in the United States and Canada. Coverage can vary outside these areas. Please contact your local representative for details.

Recycling Supplies

For information on recycling supplies, go to [www.xerox.com/gwa](http://www.xerox.com/gwa).

See also:

*Recycling and Disposal* on page 159
Managing the Printer

This section includes:

- Managing the Printer with CentreWare Internet Services on page 110
- Checking Printer Status with PrintingScout on page 111
- Checking Printer Status using Email on page 112

Managing the Printer with CentreWare Internet Services

This section includes:

- Accessing CentreWare Internet Services on page 110
- Checking the Status of the Printer on page 110
- Checking Print Job Status on page 111
- Using Online Help on page 111

CentreWare Internet Services is the administration and configuration software installed on the embedded Web server in the printer.

For details, see CentreWare Internet Services on page 25.

Accessing CentreWare Internet Services

At your computer, open a Web browser, type the IP address of the printer into the address field, then press Enter or Return.

Checking the Status of the Printer

1. In CentreWare Internet Services, click the Status button or Status tab.
   
   The general status of the printer includes:
   
   - The type, size, and amount, empty or full, of paper in each tray.
   - The ready-for-printing status of the printer.
   - The frequency with which the printer status information is refreshed.
   - The total page count of printed pages.

2. To check the supplies status of the printer, in the Status tab, click the Supplies button.
   
   The supplies status of the printer includes:
   
   - The amount remaining in each toner cartridge.
   - The percentage remaining of the life of the imaging unit.
Checking Print Job Status

CentreWare Internet Services keeps a log of current print jobs, including job names, the users who submitted them, the job status, and more. You can also get a list of all print jobs.

1. To view the status of print jobs from the main menu in CentreWare Internet Services, click the Jobs button or tab.
2. To view a job history list in the Jobs tab, expand the History List folder in the navigation pane on the left of the page. Click to open the Job History.

Using Online Help

For details about settings in CentreWare Internet Services, click the Help button. For other support information, click the Support button or tab.

Checking Printer Status with PrintingScout

Note: PrintingScout is a Windows-only application.

The PrintingScout utility automatically checks the printer status when you send a print job. PrintingScout can check the paper sizes of the trays, the status of the output tray, and the remaining consumables percentages, such as toner.

To open PrintingScout, do one of the following:

- In the Windows taskbar, double-click the PrintingScout icon.
- From the Start menu, select Programs > Xerox® Office Printing > PrintingScout > Activate PrintingScout.

The status of the printer is displayed in the General Status window that opens.

For information on using PrintingScout, see the PrintingScout help. To see Help in the Windows taskbar, right-click the PrintingScout icon and select Help.

See also:

Installing PrintingScout on page 40
Checking Printer Status using Email

This section includes:

- Configuring Email Alerts on page 112
- Using Commands in Email Text on page 113

If you are connected to the printer through the network, you can configure the printer to email you reports about the printer. Reports include:

- The network settings of the printer.
- The printer status.
- The errors that occur on the printer.

Configuring Email Alerts

In CentreWare Internet Services, configure the following settings according to your email environment. After configuring the settings on each page, always click Save Changes. For details, see Help in CentreWare Internet Services.

1. Launch your Web browser and type the IP address of your printer in the browser address field.
2. In the CentreWare Internet Services page of your printer, click the Properties button.
3. In the navigation pane on the left side of the page, click the Mail Alerts link.
4. In the Mail Alerts page, select the Enable Mail Alerts check box if it is not already selected.
5. In the SysAdmin Mail Address field, type your email address or the address to which you want email alerts sent.
6. In the Notification Items section, select the events for which you would like to be notified.
7. In the Connection Setup box, click the Email Server link.
   The Email Server page opens.
8. In the Email Server Setup (Required to send Email) section, do the following:
   a. In the Return Email Address field, type the return address used by the email server.
   b. In the SMTP Server (IP Address or DNS Name) field, type the outgoing IP address used by your SMTP server for sending email.
   Note: If you are unsure of the address or DNS name, contact your Internet Service Provider (ISP) for the correct address information.
   c. In the SMTP Port field, type the number of the port used. The default is 25.
9. In the Email Send Authentication section, do one of the following:
   - If no authentication is necessary, select No Authentication in the Authentication Type field.
   - If authentication is required, complete the fields as needed.
10. In the Email Server Setup (Required to receive Email) section, enter the appropriate information in the fields as needed.
    Note: The Email Alert function is used only for remote status monitoring. The printer does not print emails posted to the printer.
11. In the Email Filter section, enter the email addresses of the users who are permitted to send email to the printer. If no address is specified here, the printer can receive email from all users.
12. In the Email Password (Password for remote status) section, enter a password in the Password field, then enter it in the Re-enter Password field. This password controls access to the printer read only and read/write email functions.

13. Click the **Save Changes** button.

14. In the navigation pane on the left side of the page, click **Port Enabling** and then select the check boxes for the ports to enable. Be sure to enable at least the **Enable Mail Alerts** port.

15. Click the **Save Changes** button.

### Using Commands in Email Text

**Notes:**
- You can specify any title for the email when checking the printer status or changing the printer settings.
- Use the commands described in the next section to create the text of the email.

Use each command according to the following rules:
- Prefix all commands with the pound sign (#), and specify the #Password command at the top of the email.
- Command lines without the pound sign (#) are ignored.
- Type one command on each line and separate each command and parameter with a space or a tab.

When the same command is written two or more times in one email, the second and subsequent commands are ignored.

<table>
<thead>
<tr>
<th>Command</th>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>#Password</td>
<td>Password</td>
<td>Use this command at the top of the email when a password for read only or full access is set. You can omit this command when the password is not set.</td>
</tr>
<tr>
<td>#NetworkInfo</td>
<td></td>
<td>Use this command to check information on the network settings list.</td>
</tr>
<tr>
<td>#Status</td>
<td></td>
<td>Use this command to check the printer status.</td>
</tr>
<tr>
<td>#SetMsgAddr</td>
<td>Recipient email address</td>
<td>Use this command to specify the email address to which email reports are sent to. This command can only be used when the password in the #Password command specifies full access.</td>
</tr>
</tbody>
</table>

### Examples of Commands
- To check the printer status when the read-only password is ronly, for read only, use:
  ```text
  #Password ronly
  #Status
  ```
• To set the recipient email address to service@xerox.com when the full access password is admin, use:
  #Password admin
  #SetMsgAddr service@xerox.com
• To set the recipient email address to service@xerox.com, and confirm the setting result on the network settings list when the full access password is admin, use:
  #Password admin
  #SetMsgAddr service@xerox.com
  #NetworkInfo

Note: Type the #SetMsgAddr command before the #NetworkInfo command. If they are written in reverse, the information retrieved by the #NetworkInfo command and the result of executing the #SetMsgAddr command can differ.
Checking Page Counts

This section includes:

- Viewing the Billing Meter on page 115
- Printing the Print Volume Report on page 115

You can check the total number of printed pages at the printer control panel, on the Configuration Page, and in CentreWare Internet Services. Three meters are available: Total Impressions, Color Impressions, and Black Impressions. The billing meter counts the number of pages printed properly. 1-sided prints, including N-up, are counted as one impression, and 2-sided prints, including N-up, are counted as two. During 2-sided printing, if an error occurs after one side is printed properly, it is counted as one.

Color documents converted using an ICC profile on applications with the Color (Auto) setting can print in color, even if displayed in black and white. The data prints in color even if it seems to be black and white data on the monitor. In that case, the number of Color Impressions is increased.

Note: Grayscale images printed with the composite black setting count as color pages because color consumables are used. Composite black is the default setting on most printers.

When doing automatic 2-sided printing, a blank page can be inserted automatically depending on the settings in the application. In this case, the blank page is counted as one page.

Viewing the Billing Meter

The billing meter tracks the total number of pages printed for the life of the printer; it cannot be reset.

To check the total number of pages printed:
1. On the printer control panel, press the Menu button.
2. Press the Down Arrow button to go to Billing Meters and then press the OK button.
3. Press the Down Arrow button to scroll to the desired meter. The number of printed pages is displayed below the name.
4. After checking, press the Return button to exit the Billing Meters menu.

Printing the Print Volume Report

The print meter tracks print job accounting information. The information is available in the Print Volume report. The report shows the information organized by user name and by how many pages of each size were printed in color and in black and white.

To print the print meter information page:
1. On the printer control panel, press the Menu button.
2. At Information Pages, press the OK button.
3. Press the Down Arrow button to go to Print Meter and then press OK.
   The Print Volume Report prints.
Maintenance

See also:

Information Pages on page 24
Managing the Printer with CentreWare Internet Services on page 110
Moving the Printer

Follow these procedures when moving the printer.

The printer, with Tray 1 and supplies but without the optional duplex unit or 250-sheet feeder, weighs 19.8 Kg (43.6 lb.). Configured with the optional duplex unit and 250-sheet feeder, the printer weighs 24.2 Kg (53.24 lb.).

Before moving the printer, do the following:
1. Turn off the printer and disconnect the power cord and other cables from the back of the printer.

   **WARNING:** To prevent electric shock, never touch the power plug with wet hands. When removing the power cord, make sure that you pull the plug and not the cord. Pulling the cord can damage it, which can lead to fire or electrical shock.

2. Wait for the printer to cool down, about 40 minutes.
3. Remove any paper or other media from the output tray and return the paper stopper to its original, non-extended position.
4. Remove Tray 1 and set it aside.
   
   **Note:** If you are moving the printer a long distance, remove the toner cartridges to prevent toner from spilling. To prevent damage to the printer, pack the printer and toner in separate boxes.
5. If your printer configuration includes the 250-sheet feeder, remove it and its lower feeder unit by lifting the printer off it.

   **WARNING:** If the optional 250-sheet feeder is installed, uninstall it before moving the printer. If the feeder is not fixed securely to the printer, it could fall and cause injuries. For details on how to uninstall the options, refer to the instruction sheet that is bundled with each option.

   **WARNING:** To avoid injury, use two people to lift the printer off the lower feeder unit.
Maintenance

When moving the printer:

- Always use two people to lift and move the printer.
- When lifting the printer, grasp the areas as shown in the illustration.

 **Note:** Configured with the optional duplex unit and 250-sheet feeder, the printer weighs 24.2 Kg (53.24 lb.). Do not move them together. Move the Tray 2 assembly and the printer separately.

- Do not tilt the printer more than 10 degrees to the front or back, or left or right. Tilting the printer more than 10 degrees can cause toner spillage.

 **CAUTION:** Failure to repackage the printer properly can result in damage to the printer not covered by the Warranty, Service Agreement, or Total Satisfaction Guarantee.

After moving the printer:

1. Reinstall any parts you removed. If you removed the 250-sheet feeder, put the printer back on top of it.
2. Reconnect the printer to the cables and power cord.
3. Plug in and turn on the printer.
4. Adjust the color registration before using the printer. For details, see Color Registration on page 136.
Troubleshooting

This chapter includes:

- Troubleshooting Overview on page 120
- Control Panel Messages on page 122
- Problems with the Printer on page 125
- Print-Quality Problems on page 128
- Cleaning the Imaging Unit and Laser Lens on page 133
- Color Registration on page 136
- Paper Jams on page 141
Troubleshooting Overview

This section includes:

- Error and Status Messages on page 120
- PrintingScout Alerts on page 120
- Online Support Assistant on page 120
- Information Pages on page 120
- More Information on page 121

Your printer comes with a number of utilities and resources to help you troubleshoot printing problems.

Error and Status Messages

The printer control panel provides you with information and troubleshooting help. When an error or warning condition occurs, the control panel displays a message informing you of the problem.

For details, see Control Panel Messages on page 122.

PrintingScout Alerts

The PrintingScout utility automatically checks the printer status when you send a print job. If the printer is unable to print, PrintingScout displays an alert on your computer screen to let you know that the printer needs attention. Install PrintingScout from the Software and Documentation disc that came in the documentation packet with your printer. For details, see Installing PrintingScout on page 40.

Note: PrintingScout is a Windows-only application.

Online Support Assistant

The Online Support Assistant is a knowledge base that provides instructions and troubleshooting help to solve your printer problems. You can find solutions for print-quality problems, paper jams, software installation, and more.

To access the Online Support Assistant, go to www.xerox.com/office/6500support.

Information Pages

Two information pages in the printer, the Demo Page and the Error History report, can help with troubleshooting certain problems. The Demo Page prints an image using all printer colors to show the current ability of the printer to print. The Error History report prints information on up to the last 42 printer errors that occurred.

To print information pages:

1. On the printer control panel, press the Menu button.
2. At Information Pages, press the OK button.
3. Press the **Down Arrow** button to go to the desired page and then press **OK**.

### More Information

You can obtain more information about your printer from these sources:

<table>
<thead>
<tr>
<th>Resource</th>
<th>Link</th>
</tr>
</thead>
<tbody>
<tr>
<td>Technical support information for your printer. Includes online Technical Support, Recommended Media List, Online Support Assistant, driver downloads, documentation, video tutorials, and more.</td>
<td><a href="http://www.xerox.com/office/6500support">www.xerox.com/office/6500support</a></td>
</tr>
<tr>
<td>Toner for your printer</td>
<td><a href="http://www.xerox.com/office/6500supplies">www.xerox.com/office/6500supplies</a></td>
</tr>
<tr>
<td>A resource for tools and information such as interactive tutorials, printing templates, helpful tips, and customized features to meet your individual needs.</td>
<td><a href="http://www.xerox.com/office/businessresourcecenter">www.xerox.com/office/businessresourcecenter</a></td>
</tr>
<tr>
<td>Printer registration</td>
<td><a href="http://www.xerox.com/office/register">www.xerox.com/office/register</a></td>
</tr>
</tbody>
</table>
| Material Safety Data Sheets identify materials and provide information on safely handling and storing hazardous materials. |  | [www.xerox.com/msds](http://www.xerox.com/msds) (U.S. and Canada)  
[www.xerox.com/environment_europe](http://www.xerox.com/environment_europe) (European Union)  |
| Information about recycling supplies                                     | [www.xerox.com/gwa](http://www.xerox.com/gwa) |
| Routine maintenance items                                               | [www.xerox.com/office/6500supplies](http://www.xerox.com/office/6500supplies) |
Control Panel Messages

This section includes:

- **Supply Status Messages** on page 122
- **Error Messages** on page 123

The printer uses control panel messages to indicate printer status, errors, and to provide instructions.

### Supply Status Messages

Status messages tell you about the status of the printer and its supplies.

**Note:** Xxx indicates one of the following: the Yellow Toner (Y), Cyan Toner (C), Magenta Toner (M), Black Toner (K), a tray, or fuser. NNN indicates a numeric value.

<table>
<thead>
<tr>
<th>Code/Message</th>
<th>Condition/Reason/Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Replace Fuser 010-351</td>
<td>Time to replace the fuser. Replace the old fuser with a new one and then restart the printer.</td>
</tr>
<tr>
<td>Insert Fuser 010-317</td>
<td>The fuser is not installed or it is incorrectly installed. Install the fuser and then restart the printer.</td>
</tr>
<tr>
<td>Replace Imaging Unit</td>
<td>It is time to replace the imaging unit. Replace the imaging unit. For details, see the Imaging Unit instruction sheet that came in the documentation packet with your printer.</td>
</tr>
<tr>
<td>Insert Imaging Unit</td>
<td>The imaging unit is not installed. Install the imaging unit. For details, see the Imaging Unit instruction sheet that came in the documentation packet with your printer.</td>
</tr>
<tr>
<td>Insert Xxx Cartridge</td>
<td>The Xxx toner cartridge is not installed correctly or is not installed. Install the toner cartridge.</td>
</tr>
<tr>
<td>Replace Xxx Cartridge</td>
<td>The toner cartridge has become empty. Replace the old toner cartridge with a new one.</td>
</tr>
<tr>
<td>Invalid Xxx</td>
<td>The wrong toner cartridge is installed or the toner cartridge is not seated correctly. Reseat the toner cartridge or replace the cartridge with one that meets specifications for your printer. The region of your printer is listed on the Configuration Page in the General section. For details on printing the Configuration Page, see Configuration Page on page 24.</td>
</tr>
<tr>
<td>Non-Xerox® Toner</td>
<td>The printer is in the custom toner mode. This message means a non-Xerox® toner is installed. You could experience a decrease in print quality as a result.</td>
</tr>
<tr>
<td>Low Density Xxx Cartridge</td>
<td>Toner is not distributed evenly in the specified cartridge. Remove and shake the cartridge, then reinstall it.</td>
</tr>
</tbody>
</table>
### Error Messages

<table>
<thead>
<tr>
<th>Code/Message</th>
<th>Condition/Reason/Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Xxx Low</td>
<td>The toner in the specified cartridge is low. Purchase a new cartridge to replace it. For details, see <strong>Ordering Supplies</strong> on page 108.</td>
</tr>
<tr>
<td>Tray Xxx Empty</td>
<td>The specified tray is out of paper. Open the tray, insert paper, and then close the tray.</td>
</tr>
</tbody>
</table>

### Message

<table>
<thead>
<tr>
<th>Message</th>
<th>Condition/Reason/Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fuser Error</td>
<td>Check that the fuser is seated correctly, then restart the printer.</td>
</tr>
<tr>
<td>Error 010-397</td>
<td></td>
</tr>
<tr>
<td>Check Unit</td>
<td>Sealing tape is still attached to the imaging unit. Remove the tape.</td>
</tr>
<tr>
<td>Imaging Unit</td>
<td></td>
</tr>
<tr>
<td>Over Heat</td>
<td>The internal temperature of the printer is too high. The printer has been stopped. Wait one hour before restarting the printer. Ensure that the printer has adequate cooling space around it, and that the cooling vents are not blocked.</td>
</tr>
<tr>
<td>Please Wait</td>
<td></td>
</tr>
<tr>
<td>Error 042-700</td>
<td></td>
</tr>
<tr>
<td>Please Wait</td>
<td></td>
</tr>
<tr>
<td>Jam at Tray 1</td>
<td>Paper is jammed inside the paper tray. Remove the jammed paper and then open and close the front cover. For details, see <strong>Clearing Jams at Tray 1</strong> on page 142.</td>
</tr>
<tr>
<td>Check Tray 1</td>
<td></td>
</tr>
<tr>
<td>Open Front Cover</td>
<td></td>
</tr>
<tr>
<td>Jam at Tray 2</td>
<td>Paper is jammed inside the paper tray. Open Tray 2 and remove the jammed paper. Open and close the front cover. For details, see <strong>Clearing Jams at the 250-Sheet Feeder</strong> on page 145.</td>
</tr>
<tr>
<td>Check Tray 2</td>
<td></td>
</tr>
<tr>
<td>Open Front Cover</td>
<td></td>
</tr>
<tr>
<td>Chk Manual Feed</td>
<td>There is a jam at the manual feed slot. Remove the paper and then open and close the front cover. For details, see <strong>Clearing Jams at the Manual Feed Slot</strong> on page 143.</td>
</tr>
<tr>
<td>Remove Paper</td>
<td></td>
</tr>
<tr>
<td>Open and close Front Cover</td>
<td></td>
</tr>
<tr>
<td>Remove paper from Manual Feed</td>
<td>Remove the paper at the manual feed slot.</td>
</tr>
<tr>
<td>Jam at Front Cover</td>
<td>Paper is jammed inside the printer. Press the button to open the front cover and then remove the jammed paper.</td>
</tr>
<tr>
<td>Open Front Cover and Remove Paper</td>
<td></td>
</tr>
<tr>
<td>Jam at Duplexer</td>
<td>There is a paper misfeed at the duplex unit. Press the button to open the front cover and then remove the jammed paper. For details, see <strong>Clearing Jams at the Duplex Unit</strong> on page 145.</td>
</tr>
<tr>
<td>Open Front Cover</td>
<td></td>
</tr>
<tr>
<td>Lift Transfer Unit</td>
<td></td>
</tr>
<tr>
<td>Jam at Exit</td>
<td>Paper is jammed inside the printer. Open the front cover and remove the paper.</td>
</tr>
<tr>
<td>Open Front Cover and Remove Paper</td>
<td></td>
</tr>
<tr>
<td>Message</td>
<td>Condition/Reason/Solution</td>
</tr>
<tr>
<td>-------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Jam at Reg. Roll</td>
<td>There is a paper misfeed at the registration roller that helps align the paper in the printer path. Open the front cover and remove the paper.</td>
</tr>
<tr>
<td>Open Front Cover</td>
<td></td>
</tr>
<tr>
<td>Reseat Paper of Manual Feed</td>
<td>Remove and then reseat the paper in the manual feed slot.</td>
</tr>
<tr>
<td>Load Manual Feed</td>
<td>Load the correct-size paper in the manual feed slot.</td>
</tr>
<tr>
<td>Load Tray Xxx</td>
<td>The printer has detected a paper size mismatch or no suitable paper is loaded in any of the trays. Open the specified tray, remove the paper, insert paper of the correct size, and then close the tray.</td>
</tr>
<tr>
<td>Insert Output to Tray Xxx</td>
<td>Waiting for side 2 to be set for manual 2-sided printing. Insert paper from output tray into the specified tray for printing on the second side.</td>
</tr>
<tr>
<td>Side Door Open</td>
<td>The side door to the toner is open. Close the side door.</td>
</tr>
<tr>
<td>Close Side Door</td>
<td></td>
</tr>
<tr>
<td>Front Cover Open</td>
<td>The front cover is open. Close the front cover.</td>
</tr>
<tr>
<td>Close Front Cover</td>
<td></td>
</tr>
<tr>
<td>Invalid Job</td>
<td>When the printer configuration on the print driver does not conform to the printer you are using, this message is displayed. Press the Cancel button to cancel the print job. Make sure that the configuration of the printer on the print driver conforms to the printer you are using.</td>
</tr>
<tr>
<td>Press OK Button</td>
<td></td>
</tr>
<tr>
<td>Error 016-799</td>
<td></td>
</tr>
<tr>
<td>Out of Memory</td>
<td>The printer memory is full and cannot continue processing the current print job.</td>
</tr>
<tr>
<td>Press OK Button</td>
<td>Press the OK button to clear the message, cancel the current print job, and conduct the next print job, if any.</td>
</tr>
<tr>
<td>Error 016-718</td>
<td>Press the Cancel button to cancel the print job.</td>
</tr>
<tr>
<td>Collate Full</td>
<td>The memory for the collate function is full.</td>
</tr>
<tr>
<td>Press OK Button</td>
<td>Press OK and then turn off the printer and then on to clear any pending jobs. Also check the print queue of your printer to make sure that the jobs are deleted. Try sending the job again. If you still get the error message, repeat the process of clearing the print queue, then send the print job in smaller batches. If clearing the queue and sending smaller print jobs does not work, contact technical support.</td>
</tr>
<tr>
<td>Error 116-721</td>
<td></td>
</tr>
<tr>
<td>PDL Error</td>
<td>An error relating to PCL emulation has occurred.</td>
</tr>
<tr>
<td>Press OK Button</td>
<td>Press the OK button to clear the message, cancel the current print job, and conduct the next print job, if any.</td>
</tr>
<tr>
<td>Error 016-720</td>
<td>Press the Cancel button to cancel the print job.</td>
</tr>
</tbody>
</table>
## Problems with the Printer

If you encounter a problem with your printer, use the following table to troubleshoot and fix the problem. For additional troubleshooting information, see Troubleshooting Overview on page 120.

**WARNING:** Never open or remove printer covers that are secured with screws unless instructed in the manual. A high-voltage component can cause electric shock. Do not try to alter the printer configuration or modify any parts. An unauthorized modification can cause smoke or fire.

**CAUTION:** Probable causes of trouble are that the printer, computer, server, or other hardware is not correctly set for the network environment you are using.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Reason/Solution</th>
</tr>
</thead>
</table>
| No power.        | Is the power to the printer turned off?  
                    Press the power button to the **On** position to turn on the power.  
                    Is the power cord disconnected or not securely connected?  
                    Turn off the power to the printer and then connect the power cord to the power outlet again. Then turn on the power to the printer.  
                    Is the power cord connected to a power outlet with the correct voltage?  
                    Connect the printer exclusively to a power outlet with a suitable voltage and current rating. For details, see Electrical Specifications on page 150.  
                    Is the printer connected to an uninterruptible power supply?  
                    Turn off the power to the printer and then connect the power cord to a suitable power outlet.  
                    Is the printer connected to a power strip shared with other high-power devices?  
                    Connect the printer to a power strip that is not shared with other high-power devices. |
| Cannot print.    | Is the Ready indicator turned off?  
                    If so, this printer is in Energy Saver mode or in the menu setting mode. For details, see Control Panel on page 20.  
                    Is there a message displayed on the control panel?  
                    Read the message and follow the instructions to correct the problem. For details, see Control Panel Messages on page 122. |
### Troubleshooting

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Reason/Solution</th>
</tr>
</thead>
</table>
| Print job sent but the light of the Ready indicator is not blinking or on. | Is the Ethernet or USB interface cable disconnected?  
Turn off the power and check the connection of the interface cable.  
Is the protocol configured?  
Check the port status of the interface. Make sure that the protocol settings are correctly configured in CentreWare Internet Services. For details, Help in CentreWare Internet Services.  
Is the computer environment correctly set up?  
Check the computer environment, such as the print driver. For details, see Installation and Setup on page 27. |
| Error indicator is on.                                                  | Is there an error message displayed on the control panel?  
Check the displayed message and correct the error. For details, see Control Panel Messages on page 122. |
| Error indicator is blinking.                                            | An error has occurred that you cannot correct by yourself.  
Record the displayed error message or error code, turn off the power and disconnect the power plug from the outlet. Refer to the Xerox® Support website at www.xerox.com/office/6500support. |
| Light of the Ready indicator is on and blinking but there is no print output. | There are jobs remaining in the printer.  
Cancel printing or force the remaining data to be printed.  
To force the print job, press the OK button. To cancel the job, press the Cancel button. |
| Top section of printed document is missing. The top and side margins are incorrect. | Are the paper tray guides in the correct positions?  
Set the length guide and the width guides to the correct positions. For details, see Loading Paper on page 51.  
Check that the paper size on the print driver or the control panel is correctly set. For details, see Setting Paper Types and Sizes on page 58.  
For details, see the online help for the print driver.  
Check that the margin setting is correct on the print driver. (PCL only).  
For details, see the online help for the print driver. |
<p>| Condensation has occurred inside the printer.                          | Turn on the printer and leave it on for at least one hour to get rid of the condensation. If the problem continues, refer to the Xerox® Support website at <a href="http://www.xerox.com/office/6500support">www.xerox.com/office/6500support</a>. |</p>
<table>
<thead>
<tr>
<th>Symptom</th>
<th>Reason/Solution</th>
</tr>
</thead>
</table>
| Paper cannot be fed.                        | **Is the paper correctly loaded?**  
Load the paper correctly. For labels or envelopes, fan them well to allow air to enter between each sheet before loading. For details, see **Loading Paper** on page 51. |
| Paper jams.                                 | **Is the paper damp?**  
Replace with paper from a new ream. For details, see **Paper Storage Guidelines** on page 47, and **Paper Usage Guidelines** on page 46. |
| Multiple sheets are fed. Paper is fed at an angle. | **The paper used is not suitable.**  
Load the correct type of paper. For details, see **Supported Paper and Media** on page 46. |
| Paper is wrinkled.                          | **Is the paper tray set correctly?**  
Push the paper tray completely into the printer. |
|                                             | **Is the printer placed on a flat location?**  
Place the printer on a stable, flat surface. |
|                                             | **Are the paper tray guides set in the correct positions?**  
Set the guides to the correct positions. For details, see **Loading Paper** on page 51. |
| Paper is fed more than 1 sheet at a time.   | **Paper is fed more than 1 sheet at a time.**  
Multiple feeding of paper can occur before the sheets of paper loaded in the tray are used up. Remove the paper, fan it, and load again. Replenish paper only when all the sheets of the loaded paper are used up. |
| Unusual noises.                             | **The printer is not level.**  
Reposition the printer on a flat, stable surface. |
|                                             | **The paper tray is not inserted properly.**  
Push the paper tray completely into the printer. |
|                                             | **There is a foreign object inside the printer.**  
Turn off the printer and remove the foreign object. Refer to the Xerox® Support website at [www.xerox.com/office/6500support](http://www.xerox.com/office/6500support). |
## Print-Quality Problems

When the print quality is poor, select the closest symptom from the following table and see the corresponding solution to correct the problem. You can also print a demo page to more precisely determine the print-quality problem. For details, see Information Pages on page 120.

If the print quality does not improve after carrying out the appropriate action, contact Xerox® Customer Support or your reseller.

**Notes:**
- To enhance print quality, toner cartridges for many models of equipment have been designed to cease functioning at a predetermined point.
- Grayscale images printed with the composite black setting count as color pages, because color consumables are used. Composite black is the default setting on most printers.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Faded printouts/multiple colors faded</td>
<td>The toner cartridges are not Xerox® toner cartridges.</td>
<td>Verify that the toner cartridges (CMYK) meet specifications, and replace them if necessary.</td>
</tr>
<tr>
<td></td>
<td>The paper being used is outside the recommended specification range.</td>
<td>Replace the paper with a recommend size and type, and confirm that your control panel/print driver settings are correct. For details, see Supported Paper on page 48.</td>
</tr>
<tr>
<td></td>
<td>The paper is damp.</td>
<td>Replace the paper.</td>
</tr>
<tr>
<td></td>
<td>The transfer belt unit is old or damaged.</td>
<td>Replace the transfer belt unit.</td>
</tr>
<tr>
<td></td>
<td>The high-voltage supply is defective.</td>
<td>For assistance, see the Xerox® Support website at:</td>
</tr>
<tr>
<td></td>
<td></td>
<td><a href="http://www.xerox.com/office/6500support">www.xerox.com/office/6500support</a></td>
</tr>
<tr>
<td>Only one color is faded.</td>
<td>Toner cartridge is empty or damaged.</td>
<td>Check the condition of the toner cartridge and replace it if necessary.</td>
</tr>
<tr>
<td>Symptom</td>
<td>Cause</td>
<td>Solution</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Stray black dots or white areas (dropouts).</td>
<td>The paper is outside the recommended specification range.</td>
<td>Replace the paper with a recommended size and type, and confirm that your control panel(print driver) settings are correct. For details, see Supported Paper on page 48.</td>
</tr>
<tr>
<td>The transfer belt unit is old or damaged.</td>
<td></td>
<td>Replace the transfer belt unit.</td>
</tr>
<tr>
<td>The toner cartridges are not Xerox® toner cartridges.</td>
<td></td>
<td>Verify that the toner cartridges meet specifications and replace them if necessary. For details, see Consumables on page 108.</td>
</tr>
<tr>
<td>Vertical black or color streaks or multiple colored streaks or lines.</td>
<td>The transfer belt unit is old or damaged.</td>
<td>Replace the transfer belt unit.</td>
</tr>
<tr>
<td>Streaks in only one color.</td>
<td>The toner cartridges are not Xerox® toner cartridges.</td>
<td>Verify that the toner cartridges meet specifications and replace them if necessary. For details, see Consumables on page 108.</td>
</tr>
<tr>
<td>Recurring smudges.</td>
<td>Dirt in the paper path.</td>
<td>Print several blank sheets until the smudges disappear.</td>
</tr>
<tr>
<td>The paper is outside the recommended specification range.</td>
<td></td>
<td>Replace the paper with a recommended size and type, and confirm that your control panel settings are correct. For details, see Supported Paper on page 48.</td>
</tr>
<tr>
<td>The transfer belt unit or fuser is old or damaged.</td>
<td></td>
<td>Check the condition of the transfer belt unit and the fuser and replace if necessary.</td>
</tr>
<tr>
<td>Symptom</td>
<td>Cause</td>
<td>Solution</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Toner smears when rubbed.</td>
<td>The paper is damp.</td>
<td>Replace the paper.</td>
</tr>
<tr>
<td></td>
<td>The paper is outside the recommended specification range, or the paper type setting is not correct.</td>
<td>Replace the paper with a recommended size and type and then confirm that your print driver settings are correct. For details, see Supported Paper on page 48.</td>
</tr>
<tr>
<td></td>
<td>The toner cartridges are not Xerox® toner cartridges.</td>
<td>Verify that the toner cartridges meet specifications and replace if necessary. For details, see Consumables on page 108.</td>
</tr>
<tr>
<td></td>
<td>The fuser is old or damaged.</td>
<td>Replace the fuser.</td>
</tr>
<tr>
<td>Printed pages are blank.</td>
<td>Two or more sheets can be feeding at once.</td>
<td>Remove the paper stack from the tray, fan it, then reinsert it.</td>
</tr>
<tr>
<td></td>
<td>The toner cartridges are not Xerox® toner cartridges.</td>
<td>Verify that the toner cartridges meet specifications and replace if necessary. For details, see Consumables on page 108.</td>
</tr>
<tr>
<td></td>
<td>The transfer belt unit is old or damaged.</td>
<td>Replace the transfer belt unit.</td>
</tr>
<tr>
<td></td>
<td>The cable to the laser unit or controller is defective.</td>
<td>For assistance, see the Xerox® Support website at: <a href="http://www.xerox.com/office/6500support">www.xerox.com/office/6500support</a></td>
</tr>
<tr>
<td>Hair-like marks appear in or around black half-tone printing. Shadows appear around areas of dense black printing.</td>
<td>The paper was left unwrapped for a long time, especially in a dry environment.</td>
<td>Replace the paper. Also, see Paper Storage Guidelines on page 47.</td>
</tr>
<tr>
<td></td>
<td>The paper is outside the recommended specification range.</td>
<td>Replace the paper with a recommended size and type and then confirm that your print driver settings are correct. For details, see Supported Paper on page 48.</td>
</tr>
<tr>
<td></td>
<td>The transfer belt unit is old or damaged.</td>
<td>Replace the transfer belt unit.</td>
</tr>
<tr>
<td>Color around the edge of printing is incorrect.</td>
<td>The color registration is incorrect.</td>
<td>Adjust the color registration. For details, see Color Registration on page 136.</td>
</tr>
<tr>
<td>Colored dots are printed at regular intervals (about 28 mm).</td>
<td>The imaging unit is dirty.</td>
<td>Gently clean the imaging unit. For details, see Cleaning the Imaging Unit and Laser Lens on page 133.</td>
</tr>
<tr>
<td>Symptom</td>
<td>Cause</td>
<td>Solution</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-----------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Partial blanks, creased paper, or blotted printing.</td>
<td>The paper is damp.</td>
<td>Replace the paper.</td>
</tr>
<tr>
<td></td>
<td>The paper is outside the recommended specification range.</td>
<td>Replace the paper with a recommended size and type. For details, see Supported Paper on page 48.</td>
</tr>
<tr>
<td></td>
<td>The transfer belt unit or the fuser is not installed correctly.</td>
<td>Reinstall the transfer belt unit or the fuser. For details, see the instruction sheets in the documentation packet that came with your printer.</td>
</tr>
<tr>
<td></td>
<td>The toner cartridges are not Xerox® toner cartridges.</td>
<td>Verify that the toner cartridges meet specifications and replace if necessary. For details, see Consumables on page 108.</td>
</tr>
<tr>
<td></td>
<td>Condensation inside the printer causes partial blanks or creased paper.</td>
<td>Turn on the printer and leave it on for at least one hour to get rid of the condensation. If the problems still occur, for assistance see the Xerox® Support website: <a href="http://www.xerox.com/office/6500support">www.xerox.com/office/6500support</a></td>
</tr>
<tr>
<td>Vertical blanks.</td>
<td>The laser is being blocked.</td>
<td>Remove the imaging unit and clean all debris from the laser lens with a lint-free cloth. For details, see Cleaning the Imaging Unit and Laser Lens on page 133.</td>
</tr>
<tr>
<td></td>
<td>The transfer belt unit or fuser is old or damaged.</td>
<td>Check the condition of the transfer belt unit and fuser, and replace if necessary.</td>
</tr>
<tr>
<td></td>
<td>The toner cartridges are not Xerox® toner cartridges.</td>
<td>Verify that the toner cartridges meet specifications and replace if necessary.</td>
</tr>
<tr>
<td>Slanted printing.</td>
<td>The paper guides in the trays are not set correctly.</td>
<td>Reset the paper tray guides. For details, see Loading Paper on page 51.</td>
</tr>
<tr>
<td>Horizontal bands, approximately 22 mm wide, appear vertically every 73 mm.</td>
<td>The imaging unit has been exposed to too much light; possibly from leaving the front door open too long.</td>
<td>Replace the imaging unit.</td>
</tr>
</tbody>
</table>
## Troubleshooting

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Colors are blurry or there is white area around objects.</td>
<td>Color-to-color alignment is not correct.</td>
<td>Perform an automatic color registration adjustment. For details, see Color Registration on page 136.</td>
</tr>
</tbody>
</table>
Cleaning the Imaging Unit and Laser Lens

If prints have voids or light streaks through one or more color, use the following instructions to clean the imaging unit and laser lens.

**Note:** Do not use warm water or cleaning solvents to remove toner from your skin or clothing. Warm water sets the toner and makes it difficult to remove. If toner gets on your skin or clothing, brush it off, blow it off, or wash it off with cold water and mild soap.

**CAUTION:** Do not expose the imaging unit to strong light, and minimize its exposure to light in general to five minutes or less if possible.

1. Switch off the printer at the power switch located on the left side of the printer toward the back.
2. Wait until the printer has cooled (about 40 minutes).
3. Remove Tray 1 and set it aside.
4. Open the printer by pressing the front cover button on the right side of the printer near the top.
5. Fold down the transfer belt unit, being careful not to touch its shiny surface.
6. Using a flashlight, inspect the gaps in the imaging unit and remove any paper debris from the area.
7. Remove the imaging unit:

   **CAUTION:** Do not drop or shake the imaging unit after removal because toner can spill from it.

   **CAUTION:** Do not expose the imaging unit to any light source for more than five minutes. Prolonged exposure to light can damage the unit. Cover the imaging unit while it is exposed. Do not touch the shiny blue transfer belt unit. For details, see Internal Components on page 19.

   a. Turn the four peach-colored twist-locks to the left to unlock the imaging unit.

   ![Image of imaging unit with twist-locks turned](p6500-025)

   ![Image of imaging unit being pulled out](p6500-026)

   b. Grasp the imaging unit by its peach-colored pull tabs on the top edge and then pull the unit forward and up out of the printer.

   c. Place the imaging unit on a flat surface and cover it with a sheet of paper to minimize its exposure to light.

8. Using a clean, dry, lint-free cloth or swab, clean all debris from the laser lens.

![Image of cleaning laser lens](p6500-042)

9. Check for and remove any debris around the imaging unit gears located on the left side of the unit.
10. Reinstall the imaging unit:
   a. Grasp the unit by its peach-colored pull-tabs on the top edge and install the unit in the printer. Make sure to insert the unit into the guides in the printer and then push the unit all the way back into the printer.

   b. Turn the four twist-locks to the right to lock the unit.

11. Fold the transfer belt unit back into place and close the printer front cover.
Color Registration

This section includes:
- Enabling/Disabling Automatic Color Registration on page 136
- Performing an Automatic Color Registration Adjustment on page 136
- Performing a Manual Color Registration Adjustment on page 137

The printer automatically adjusts the color registration when automatic adjustment is enabled. You can manually adjust color registration at any time the printer is idle. Adjust the color registration any time the printer is moved. If you are having printing problems, adjust the color registration. For details, see Print-Quality Problems on page 128.

Enabling/Disabling Automatic Color Registration

Use the following procedure to enable or disable the automatic color registration adjustment feature.
1. On the printer control panel, press the Menu button.
2. Press the Down Arrow button to go to Admin Menu and then press the OK button.
3. Press the Down Arrow button to scroll to Maintenance Mode and press OK.
4. Press the Down Arrow button to scroll to Auto Regi Adjust and press OK.
5. Do one of the following:
   - To enable the feature, at On press OK.
   - To disable the feature, press the Down Arrow button to scroll to Off and press OK.
6. Press the Return button to return to the main menu.

Performing an Automatic Color Registration Adjustment

Use the following procedure to perform automatic color registration adjustment.

   Note: An automatic color registration adjustment is performed every time a new toner cartridge is installed.

1. On the printer control panel, press the Menu button.
2. Press the Down Arrow button to go to Admin Menu and then press the OK button.
3. Press the Down Arrow button to scroll to Maintenance Mode and press OK.
4. Press the Down Arrow button to scroll to Adjust Color Regi and press OK.
5. At Auto Adjust, press OK.
6. At the prompt, Are you sure?, press the Up Arrow or Down Arrow button to select Yes.
7. Press OK to begin the calibration.
   When the adjustment is complete, the printer control panel displays Ready.
Performing a Manual Color Registration Adjustment

You can fine-tune color registration by performing a manual adjustment. Manual color registration adjustment is a three-step process:

1. Printing the Color Registration Correction Chart on page 137.
2. Determining the Color Registration Values on page 137.

Printing the Color Registration Correction Chart

1. On the printer control panel, press the Menu button.
2. Press the Down Arrow button to go to Admin Menu and then press the OK button.
3. Press the Down Arrow button to scroll to Maintenance Mode and press OK.
4. Press the Down Arrow button to scroll to Adjust Color Regi and press OK.
5. Press the Down Arrow button to scroll to Color Regi Chart and press OK.
6. Press the up Arrow or Down Arrow button to select Yes, then press OK.
   The Color Registration Chart prints.
7. Continue to Determining the Color Registration Values on page 137 to determine if an adjustment is necessary.

Determining the Color Registration Values

The Color Registration Chart shows horizontal and vertical values for each color. The horizontal values are:

- LY = left yellow
- LM = left magenta
- LC = left cyan
- RY = right yellow
- RM = right magenta
- RC = right cyan

The vertical values are:

- PY = paper feed direction yellow
- PM = paper feed direction magenta
- PC = paper feed direction cyan

To determine the horizontal values:

1. In the top section of the Color Registration Chart, lines are displayed next to the color letters LY, LM, LC, RY, RM, and RC. Some lines are straight and other lines are jagged. A value is listed next to each line. For each color, examine the lines and determine which one is the straightest. Refer to the enlarged illustration on the chart that shows how to determine the closest number.

2. For each color, do one of the following:
   - If zero (0) is the value nearest the straightest line, you do not need to adjust the color registration.
• If zero (0) is not the value nearest the straightest line, write down the number that is closest.

3. Proceed to determining the vertical values described in the following procedure.

To determine the vertical values:

1. In the lower section of the Color Registration Chart, columns of color are displayed with a wavy white column where there is no color. Identify the column of white that is the straightest. Refer to the enlarged illustration on the chart that shows how to determine the closest number.

2. For each color, do one of the following:
   • If zero (0) is the value closest to the middle of the white band, you do not need to adjust that color.
   • If zero (0) is not the value closest to the middle of the white band, write down the number that is closest.

3. If it is necessary to make any horizontal or vertical adjustments, proceed to Entering Color Registration Value on page 138.

**Entering Color Registration Value**

Using the printer control panel, enter the values that you found in the Color Registration Correction Chart to make adjustments.

1. On the control panel, press the **Menu** button.
2. Press the **Up Arrow** or **Down Arrow** button to select **Admin Menu**, then press the **OK** button.
3. Press the **Up Arrow** or **Down Arrow** button to select **Maintenance**, then press **OK**.
4. Press the **Up Arrow** or **Down Arrow** button to select **Adjust Color Regi**, then press **OK**.
5. Press the **Up Arrow** or **Down Arrow** button to select **Enter Number**, then press **OK**.
6. Adjust the Left Horizontal registration values:
   a. Press the **Up Arrow** or **Down Arrow** button to select the LY value from the Color Registration Correction Chart. Press the **Forward Arrow** button to adjust the next value.
   b. Press the **Up Arrow** or **Down Arrow** button to select the LM value from the Color Registration Correction Chart. Press the **Forward Arrow** button to adjust the next value.
   c. Press the **Up Arrow** or **Down Arrow** button to select the LC value from the Color Registration Correction Chart. Press **OK** to move to the next screen.
7. Adjust the Right Horizontal registration values:
   a. Press the **Up Arrow** or **Down Arrow** button to select the RY value from the Color Registration Correction Chart. Press the **Forward Arrow** button to adjust the next value.
   b. Press the **Up Arrow** or **Down Arrow** button to select the RM value from the Color Registration Correction Chart. Press the **Forward Arrow** button to adjust the next value.
   c. Press the **Up Arrow** or **Down Arrow** button to select the RC value from the Color Registration Correction Chart. Press **OK** to move to the next screen.
8. Adjust the Process Vertical registration values:
   a. Press the **Up Arrow** or **Down Arrow** button to select the PY value from the Color Registration Correction Chart. Press the **Forward Arrow** button to adjust the next value.
   b. Press the **Up Arrow** or **Down Arrow** button to select the PM value from the Color Registration Correction Chart. Press the **Forward Arrow** button to adjust the next value.
c. Press the Up Arrow or Down Arrow button to select the PC value from the Color Registration Correction Chart.

9. When the registration value adjustments are complete, press OK.

10. Print the chart again to check the values:
    a. Press the Up Arrow or Down Arrow button to select Color Regi Char, then press OK.
    b. Press the Up Arrow or Down Arrow button to select Yes, then press OK.

    Note: For details, see Printing the Color Registration Correction Chart on page 137.

11. If 0 is not displayed next to the straight lines, examine the chart and determine additional correction values.

12. When satisfied that the horizontal adjustment is complete, press the Back button to return to the Ready screen.
Color Balance

The printer automatically rebalances the color when printer consumables are replaced, or when changes in environmental conditions occur. To perform this manually one time, use the following procedure.

To adjust the color balance for the printer:
1. On the control panel, press the Menu button.
2. Press the Up Arrow or Down Arrow button to select Admin Menu, then press the OK button.
3. Press the Up Arrow or Down Arrow button to select Maintenance, then press OK.
4. Press the Up Arrow or Down Arrow button to select Drum Refresh, then press OK.
5. At the Are you sure? prompt, press OK.
   The process runs automatically. Wait about three minutes for the process to complete and the printer to return to Ready.
Paper Jams

This section includes:

- Preventing Paper Jams on page 141
- Clearing Paper Jams on page 142

Preventing Paper Jams

To reduce the occurrence of paper jams, follow the guidelines and instructions in Supported Paper and Media on page 46. It includes paper-usage guidelines and instructions for properly loading paper in the trays.

To prevent paper and other media misfeeds and printer jams, follow these guidelines:

- Make sure that the paper used matches the specifications for each tray in the printer.
- Stack media so that it is flat and level, especially on the leading edge.
- Make sure the printer is on a hard, flat, level surface.
- Store paper and other media in a dry location away from moisture and humidity.
- Always adjust the paper guides in Tray 1 after inserting the media. A guide that is not properly adjusted can cause poor print quality, paper misfeeds, and printer damage.
- Avoid using paper that is folded, wrinkled, or excessively curled.
- Avoid double feeding. Remove the paper and fan the sheets to prevent them from sticking together.
- Do not load more than one type, size, or weight of paper in a tray at the same time.
- Do not overfill the trays.
- Do not allow the output tray to overfill; misfeeding can occur if you allow too many sheets of paper to accumulate at one time.

WARNING: When removing jammed paper, make sure that no pieces of torn paper are left in the printer. If a sheet of paper is wrapped around the heat roller, do not try to remove it. Power off the printer using the power switch of the printer, and then contact Technical Support for additional assistance. Turn off the printer to remove jammed paper that is difficult or impossible to see.

WARNING: The fuser and the surrounding area are hot and can cause burns.
Clearing Paper Jams

This section includes:
- Clearing Long Paper Jams on page 142
- Clearing Jams at Tray 1 on page 142
- Clearing Jams at the Manual Feed Slot on page 143
- Clearing Jams at the Fuser on page 144
- Clearing Jams at the 250-Sheet Feeder on page 145
- Clearing Jams at the Duplex Unit on page 145

Clearing Long Paper Jams

When paper longer than 356 mm jams inside the printer, cut the paper as needed. After cutting, remove it in the proper way depending on the place that the paper jam occurs.

CAUTION: If it is difficult to open the front cover, do not force it. Turn off the printer using the power switch on the left side of the printer, toward the back. For additional assistance, refer to the Xerox® Support website at www.xerox.com/office/6500support.

Clearing Jams at Tray 1

1. Pull the jammed paper gently out of the paper tray and then remove any remaining paper from the tray.

2. Close the paper tray and then press the front cover button and open the front cover.

WARNING: Some components inside the printer, such as the fuser and surrounding area, are hot and can cause burns.
3. Carefully remove any jammed paper in the printer. Confirm that there are no scraps of paper left inside.

   **CAUTION:** Prolonged exposure to light can damage the imaging unit. Do not leave the cover open for more than five minutes at a time.

4. Close the front cover.
5. Remove the tray from the printer and then carefully pull out any jammed paper remaining inside the printer.

6. Reinsert the tray into the printer.

   **CAUTION:** Do not use excessive force on the tray; doing so could damage the tray or the inside of the printer.

**Clearing Jams at the Manual Feed Slot**
1. Pull Tray 1 out of the printer.
Troubleshooting

2. Remove any jammed or damaged paper in the tray and then close the tray.
3. Press the front cover button to open the cover.
4. Carefully remove any jammed paper in the printer. Make sure that there are no torn pieces of paper inside the printer.
5. Close the front cover.

Clearing Jams at the Fuser.

**WARNING:** Never touch a labeled area found on or near the heat roller in the fuser. You can get burned. If a sheet of paper is wrapped around the heat roller, do not try to remove it immediately. To avoid injuries or burns, turn off the printer immediately and wait 40 minutes for the fuser to cool.

**WARNING:** When removing jammed paper, make sure that no torn pieces of paper are left in the printer. A piece of paper remaining in the printer can cause a fire. If a sheet of paper is wrapped around the heat roller, turn off the printer to remove it. Turn off the printer to remove a jammed sheet of paper that is difficult to see.

**CAUTION:** Do not expose the imaging unit to any light source for more than 5 minutes. Prolonged exposure to light can damage the unit. Do not touch the shiny black transfer belt unit.

For additional assistance, refer to the Xerox® Support website at [www.xerox.com/office/6500support](http://www.xerox.com/office/6500support)

1. Press the front cover button on the side of the printer and open the printer cover.
2. Being careful not to touch the fuser, lift the levers at both sides of the fuser to release the roller pressure. At the top of the fuser, lift the green labeled tab to open the top cover and remove the jammed paper. If the paper is torn, remove any scraps of paper remaining inside the printer.

3. Put the fuser tabs back into place and then close the front cover of the printer.
Clearing Jams at the 250-Sheet Feeder

**Note:** Paper jammed in the lower tray can block the trays above it, preventing you from opening them. Look for the jammed paper sequentially, starting with the lowest tray.

1. Pull out the paper trays until you find the jammed paper.
2. Remove all jammed and creased paper from the tray.
3. Pull the jammed paper out carefully to avoid tearing it. If the paper is torn, remove the scraps.
4. Press the front cover button and open the printer cover. Confirm that there are no scraps of paper remaining inside the printer.

**CAUTION:** Prolonged exposure to light can damage the imaging unit.

**WARNING:** Some components inside the printer, such as the fuser and surrounding area, are hot and can cause burns.

5. Close the printer cover and then reinsert the trays.

**CAUTION:** Do not use excessive force on the tray. Doing so could damage the tray or the inside of the printer.

Clearing Jams at the Duplex Unit

1. Press the front cover button and open the printer cover.

**WARNING:** Some components inside the printer, such as the fuser and surrounding area, are hot and can cause burns.
Troubleshooting

2. Gently pull out the jammed paper. If you cannot find the jammed paper, go to the next step.

3. Lift the duplex unit by the recessed slot provided and open the unit fully.

4. Remove the jammed paper and then confirm that there are no scraps of paper left inside the duplex unit or transfer belt unit.

5. Close the duplex unit and then close the printer cover.

   Note: To remove the entire duplex unit, after opening the front cover of the printer, press the front cover-release button again to release the duplex unit.
This chapter includes:

- **Physical Specifications** on page 148
- **Environmental Specifications** on page 149
- **Electrical Specifications** on page 150
- **Performance Specifications** on page 151
## Physical Specifications

### Weights and Dimensions

<table>
<thead>
<tr>
<th>Part</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printer</td>
<td>Width: 403 mm (15.9 in.)</td>
</tr>
<tr>
<td></td>
<td>Depth: 469 mm (18.5 in.)</td>
</tr>
<tr>
<td></td>
<td>Height: 416.1 mm (16.4 in.)</td>
</tr>
<tr>
<td></td>
<td>Weight: 19.8 Kg (43.6 lb.)</td>
</tr>
<tr>
<td>250-Sheet Feeder (optional)</td>
<td>Width: 400 mm (15.8 in.)</td>
</tr>
<tr>
<td></td>
<td>Depth: 457 mm (18 in.)</td>
</tr>
<tr>
<td></td>
<td>Height: 108 mm (4.2 in.)</td>
</tr>
<tr>
<td></td>
<td>Weight: 4.4 Kg (9.7 lb.)</td>
</tr>
<tr>
<td>Duplex Unit (optional)</td>
<td>Width: 326.5 mm (12.9 in.)</td>
</tr>
<tr>
<td></td>
<td>Depth: 310 mm (12.2 in.)</td>
</tr>
<tr>
<td></td>
<td>Height: 153.5 mm (6.1 in.)</td>
</tr>
<tr>
<td></td>
<td>Weight: 1.2 Kg (2.65 lb.)</td>
</tr>
</tbody>
</table>
Environmental Specifications

Temperature
10°–32°C (50°–90°F)

Relative Humidity

Note: Under extreme environment conditions, such as 10°C and 85% RH, defects can occur due to condensation approximately 30 minutes after the printer is turned on.

15–85% RH at 28°C (82°F)

Elevation

For optimum performance, use the printer at elevations below 3,100 m (10,170 ft.).
Electrical Specifications

Power Source

- 110–127 V, 50/60 Hz, 10 A or less
- 220–240 V, 50/60 Hz, 5 A or less

Power Consumption

- Energy Saver Mode (Sleep Mode): 8 W or less
- Standby Mode: 50 W or less (fuser on)
- Continuous color printing: 600 W or less
- Continuous monochrome printing: 600 W or less

This printer does not consume electric power when the power switch is turned off even if the printer is connected to an AC outlet.

- ENERGY STAR qualified printer
- Default time to Energy Saver is 30 minutes
Performance Specifications

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Warm-up time</td>
<td>Power on: 30 seconds or less. Recovery from Energy Saver mode: 25 seconds or less. (assume temperature of 22°C/71.6°F)</td>
</tr>
</tbody>
</table>
| Continuous print speed                    | Color: 24 ppm  
Black and White: 24 ppm  
**Note**: Print speed can decrease due to paper type, paper size, printing conditions, or image quality adjustment. |
| 2-sided print speed (Phaser 6500DN configuration only) | Color: 23 ppm (A4)/24 ppm (Letter)  
Black and White: 23 ppm (A4)/24 ppm (Letter) |
| Resolution                                | Standard: 600 x 600 dpi x 1-bit  
Enhanced: 600 x 600 dpi x 4-bit (PostScript driver)/5-bit (PCL driver) |
Printer Specifications
Regulatory Information

This chapter includes:

- Electromagnetic Interference on page 154
- Material Safety Data Sheets on page 157
Electromagnetic Interference

Xerox® has tested this product to electromagnetic emission and immunity standards. These standards are designed to mitigate interference caused or received by this product in a typical office environment.

United States FCC Regulations

This equipment was tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential environment. This equipment generates, uses, and can radiate radio frequency energy. If it is not installed and used in accordance with these instructions, it can cause harmful interference to radio communications. However, there is no guarantee that interference does not occur in a particular installation.

To determine if this printer is causing harmful interference to radio or television reception, turn the printer off and on. If this equipment does cause harmful interference to radio or television reception, correct the interference by one or more of the following measures:

- Reorient or relocate the receiver.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/television technician for help.

Any changes or modifications not expressly approved by Xerox® could void the authority of the user to operate the equipment. To ensure compliance with Part 15 of the FCC rules, use shielded interface cables.

Canada Regulations

This Class B digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.
European Union

The CE mark applied to this product symbolizes a declaration by Xerox® of conformity with the following applicable Directives of the European Union as of the dates indicated:

- December 12, 2006: Low Voltage Directive 2006/95/EC

This product, if used properly in accordance with the instructions, is not dangerous for the consumer or to the environment.

To ensure compliance with European Union regulations, use shielded interface cables.

A signed copy of the Declaration of Conformity for this product can be obtained from Xerox®.
Other Regulations

Turkey RoHS Regulation

In compliance with Article 7 (d), we hereby certify: "It is in compliance with the EEE Regulation."
"EEE yönetmeliğine uygundur."
Material Safety Data Sheets

For Material Safety Data information regarding your printer, go to:

- North America: www.xerox.com/msds
- European Union: www.xerox.com/environment_europe

For Customer Support Center phone numbers, go to www.xerox.com/office/worldcontacts.
Recycling and Disposal

This chapter includes:

- All Countries on page 159
- North America on page 159
- Other Countries on page 159
- European Union on page 159

All Countries

If you are managing the disposal of your Xerox® product, please note that the product may contain lead, mercury, perchlorate, and other materials whose disposal may be regulated due to environmental considerations. The presence of these materials is fully consistent with global regulations applicable at the time the product was placed on the market. For recycling and disposal information, contact your local authorities. Perchlorate material: This product may contain one or more Perchlorate-containing devices, such as batteries. Special handling may apply, please see www.dtsc.ca.gov/hazardouswaste/perchlorate.

North America

Xerox® operates a program for equipment take back and reuse/recycle. Contact your Xerox® sales representative (1-800-ASK-XEROX) to determine whether this Xerox® product is part of the program. For more information about Xerox® environmental programs, visit www.xerox.com/environment. For recycling and disposal information, contact your local authorities.

Other Countries

Please contact your local waste authorities and request disposal guidance.

European Union

Some equipment can be used in both a domestic/ household and a professional/business application.
Domestic/Household Environment

Application of this symbol on your equipment is confirmation that you do not dispose of the equipment in the normal household waste stream.

In accordance with European legislation, end of life electrical and electronic equipment subject to disposal must be segregated from household waste.

Private households within EU member states can return used electrical and electronic equipment to designated collection facilities free of charge. Please contact your local disposal authority for information.

In some member states, when you purchase new equipment, your local retailer could be required to take back your old equipment free of charge. Please ask your retailer for information.

Professional/Business Environment

Application of this symbol on your equipment is confirmation that you must dispose of this equipment in compliance with agreed national procedures.

In accordance with European legislation, end of life electrical and electronic equipment subject to disposal must be managed within agreed procedures.

Before disposal, please contact your local reseller or Xerox® representative for end of life datebook information.
Information for Users on Collection and Disposal of Old Equipment and Used Batteries

These symbols on the products and/or accompanying documents mean that used electrical and electronic products and batteries do not get mixed with general household waste.

For proper treatment, recovery and recycling of old products and used batteries, take them to applicable collection points. Dispose of them in accordance with your national legislation and the Directive 2002/96/EC and 2006/66/EC.

By disposing of these products and batteries correctly, you help to save valuable resources and prevent potential negative effects on human health and the environment. Inappropriate waste handling could have negative effects on human health and the environment.

For more information about collection and recycling old products and batteries, please contact your local authorities. These authorities include your local municipality, your waste disposal service, and the point of sale where you purchased the items.

Penalties could be applicable for incorrect disposal of this waste, in accordance with national legislation.

Business Users in the European Union

If you wish to discard electrical and electronic equipment, please contact your dealer or supplier for further information.

Outside the European Union

These symbols are only valid in the European Union. If you wish to discard these items, please contact your local authorities or dealer and ask for the correct method of disposal.

Note for the Battery Symbol

This wheeled bin symbol can be used in combination with a chemical symbol. Use of this symbol establishes compliance with the requirements set out by the Directive.

Battery Removal

Have batteries replace only by a MANUFACTURER approved service facility.
Recycling and Disposal